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LICENSE AGREEMENT

LICENSE AGREEMENT

BEFORE OPENING THIS PACKAGE, YOU SHOULD CAREFULLY
READ THE FOLLOWING TERMS AND CONDITIONS. BY OPENING
THIS PACKAGE YOU AGREE TO BECOME BOUND BY THE TERMS
AND CONDITIONS OF THIS AGREEMENT, WHICH INCLUDES THE
SOFTWARE LICENSE AND LIMITED WARRANTY. IF YOU DO NOT
AGREE WITH THESE TERMS AND CONDITIONS, YOU SHOULD
PROMPTLY RETURN THE PACKAGE UNOPENED TO HITACHI
SOFTWARE ENGINEERING AMERICA, LTD.("HISAL") or HISAL
Distributor AND YOUR MONEY WILL BE REFUNDED.

The enclosed software is licensed, not sold, to you for use only upon the terms of this
Agreement, and HISAL reserves any rights not expressly granted to you. You are
responsible for the selection of the Software to achieve your intended results, and for the
installation, use and results obtained from the Software. You own the media on which the
Software is originally or subsequently recorded or fixed, but HISAL retains ownership of

all copies of the Software itself.

LICENSE

You may:

a. Use the Software on a single machine at any given time.

b. Obtain limited numbers of Copy Protection Devices. Additional, Copy Protection
Devices are provided only as a convenience of running the software.

c. In no manner engineer or reverse-engineer the copy protection hardware, or whole or part
of the software.

d. Copy the software only for backup provided that you reproduce all copyright and other
proprietary notices that are on the original copy of the Software provided to you. Certain
Software, however, may include mechanisms to limit or inhibit copying. Such Software is
marked copy protected.

e. Transfer of the Software and all rights under this Agreement to another party together
with a copy of this Agreement if the other party agrees to accept the terms and conditions

of this Agreement. If you transfer the Software, you must at the same time either transfer all
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LICENSE AGREEMENT

copies whether in printed or machine-readable form, to the same party or destroy and

copies not transferred.

RESTRICTIONS

You may not use, copy, modify, or transfer the Software, or any copy, in whole or in part,
except as expressly provided for in this Agreement. Any attempt to transfer any of the
rights, duties or obligations hereunder except as expressly provided for in this Agreement is

void.
YOU MAY NOT RENT, LEASE, LOAN, RESELL FOR PROFIT, OR DISTRIBUTE.

TERM

This Agreement is effective until terminated. You may terminate it at any time by
destroying the Software together with all copies in any form. This Agreement will
immediately and automatically terminate without notice if you fail to comply with any term
or condition of this Agreement. You agree upon termination to promptly destroy the

Software together with all copies in any form.

LIMITED WARRANTY

HISAL warrants, for the period of ninety (90) days from the date of delivery of the
Software to you as evidenced by a copy of your receipt, that:

(1) The Software, unless modified by you, will perform the function described in the
documentation provided by HISAL. Your sole remedy under the warranty is that HISAL
will undertake to correct within a reasonable period of time any marked Software Error
(failure of the Software to perform the functions described in the documentation).

HISAL does not warrant that the Software will meet your requirements, that operation of
the Software will be uninterrupted or error-free, or that all Software Errors will be
corrected.

(2) The media on which the Software is furnished will be free from defects in materials and
workmanship under normal use. HISAL will, at its option, replace or refund the purchase
price of the media at no charge

to you, provided you return the faulty media with proof of purchase to HISAL. HISAL will
not have any responsibility to replace or refund the purchase price of the media damaged by

accident, abuse or misapplication.

THE ABOVE WARRANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER
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WARRANTIES, WHETHER EXPRESS OR IMPLIED, INCLUDING THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY HISAL,
ITS EMPLOYEES, DISTRIBUTORS, OR AGENTS SHALL INCREASE THE SCOPE
OF THE ABOVE WARRANTIES OR CREATE ANY NEW WARRANTIES. SOME
STATES DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE
ABOVE EXCLUSION MAY NOT APPLY TO YOU. IN THAT EVENT, ANY IMPLIED
WARRANTIES ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE
DATE OF DELIVERY OF THE SOFTWARE. THIS WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHER RIGHTS, WHICH VARY
FROM STATE TO STATE.

LIMITATIONS OF REMEDIES

HISAL's entire liability to you and your exclusive remedy shall be the replacement of the
Software media or the refund of your purchase price as set forth above. If HISAL or the
HISAL's distributors are unable to deliver replacement media which is free of defects in
materials and workmanship, you may terminate this Agreement by returning the Software

and your money will be refunded.

REGARDLESS OF WHETHER ANY REMEDY SET FORTH HEREIN FAILS ITS
ESSENTIAL PURPOSE, IN NO EVENT WILL HISAL BE LIABLE TO YOU FOR ANY
DAMAGES, INCLUDING ANY LOST PROFITS, LOST DATA OR OTHER
INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR
INABILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY OTHER PARTY.
SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OR
LIABILITY FOR INCIDENTAL OR CONSEQUENTIAL DAMAGES TO THE ABOVE
LIMITATION OR EXCLUSION MAY NOT APPLY TO YOU.

GOVERNMENT LICENSEE

If you are acquiring the Software on behalf of any unit or agency of the United States
Government, the following provisions apply:

The Government acknowledges HISAL's representation that the Software and its
documentation were developed at private expense and no part of them is in the public

domain.
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The Government acknowledges HISAL's representation that the Software is Restricted
Computer Software as that term is defined in Clause 52.227-19 of the Federal Acquisition
Regulations (FAR) and is commercial Computer Software as that term is defined in Subpart
227.401 of the Department of Defense Federal Acquisition Regulations supplement
(DFARS) The Government agrees that:

If the Software is supplied to the Department of Defense (DOD), the Software is classified
as Commercial Computer Software and the Government is acquiring only restricted rights
in the Software and its documentation will be as defined in Clause 52.227-19 (c¢) (2) of the
FAR.

If the Software is supplied to any unit or agency of the United States Government other

than DOD, the Governments rights in Software and its documentation

RESTRICTED RIGHTS LEGEND

Use, duplication, or disclosure by the Government is subject to restrictions as set forth in
subparagraph.

(c) (1) (11) of the rights in Technical Data and computer software clause of DFARS
52.227-7013.

Hitachi Software Engineering America, Ltd.

601 Gateway Boulevard, Suite 100

South San Francisco, CA 94080

EXPORT LAW ASSURANCES

You acknowledge and agree that the Software is subject to restrictions and controls
imposed by the United States Export Administration Act (“The Act”) and the regulations
thereunder. You agree and certify that neither the Software nor any direct product thereof is
being or will be acquired, shipped, transferred or reexported, directly or indirectly, into any
country prohibited by the Act and the regulations thereunder or will be used for any
purpose prohibited by the same.

GENERAL

This agreement will be governed by the laws of the State of California, except for that body
of law dealing with conflicts of law.

Future updates of the Software will be available for purchase by licensees for a fee

provided a registration card has been received by Hitachi Software Engineering America,
Ltd.
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Should you have any questions concerning this Agreement, you may contact HISAL at
http://www.miraibio.com.

You acknowledge that you have read this Agreement, understand it and agree to be bound
by its terms and conditions. You further agree that it is the complete and exclusive
statement of the agreement between us which supersedes any proposal or prior agreement,
oral or written, and any other communications between us in relation to the subject matter

of this Agreement.
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CHAPTER1
WELCOME
MiraiBio MasterPlex® EX

CHAPTER
1

Welcome to the MiraiBio MasterPlex® EX User Manual. MasterPlex® EX
software analyzes results files (*.csv, *xls, *.Ixd or *.mix*) from the
Luminex® 100/200 or BioPlex system.

11
About This Manual

This manual explains how to use the MasterPlex® EX software to:
Import results files (*.csv, *.xls, *.Ixd or *.mlx*) from the Luminex
system
Designate control, treatment and background wells
Set housekeeping gene
Normalization and compute fold change
Generate data charts and reports
What’s New in MasterPlex® EX
MasterPlex® EX offers new features, including the ability to:
Merge plates using virtual plate feature so that it can analyzes beyond
100 panels at one time
Make a sample marking and groups easily and quickly using
Auto-grouping feature or dragging grouping feature
Calculate a fold change for being used relative gene analysis
Normalize the data so that it can analyze between different plates
Generate a custom reports using style sheet
Conventions Used in This Manual
This manual describes the steps required to perform the various tasks
associated with the MasterPlex® EX software. The manual uses a step format
to explain the various tasks associated with MasterPlex® EX. A symbol may
follow a step instruction. It indicates the software response to the action
performed by the user.

MasterPlex® EX www.miraibio.com
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WELCOME

Screen Captures

Screen captures may accompany the step instructions for further illustration.
The screen captures in this manual may not exactly match those displayed on
your screen.

1.2
Technical Support

You can contact MiraiBio Technical support at:
Hitachi Software Engineering America, Ltd.
601 Gateway Boulevard, Suite 100
South San Francisco, CA 94080
USA
Tel: +1 (650) 615-7600
Toll Free: +1 (888) 615-9600
Fax: +1 (650) 615-7639
E-mail: support@miraibio.com
www.miraibio.com

MasterPlex® EX www.miraibio.com
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CHAPTER2
INSTALLING MASTERPLEX®

CHAPTER

2 | Installing MasterPlex®

This chapter explains the minimum hardware and software requirements
needed to install and use MasterPlex® EX. It provides installation instructions
for a computer connected to the Luminex® 100/200 or BioPlex system.

21

Requirements

For optimum performance, MasterPlex® EX requires hardware and software
that meet or exceed the following specifications. It is also strongly
recommended that you use the Luminex XY platform.

Minimum Hardware Requirements

Platform PC
CPU Intel Pentium 4 2 GHz or equivalent,

Intel Pentium 4 2 GHz or better (recommended)
Memory (RAM) 512MB or higher for Windows XP/Vista/7

Storage space
(HDD)

120 MB available hard drive space for the installation

Input devices

Keyboard and mouse or other pointing device

Video RAM

32MB or higher

Monitor resolution

XGA (1024x768 pixels or higher; 1280 x1024
recommended)

Monitor color

16-bit color (high color) or higher

CD-ROM drive

Required for CD media version. Not applicable for
download version.

Software Requirements

Operating system

Microsoft Windows XP/Vista/7,
Microsoft .NET3.5 framework and
Windows Media Player 10 or higher required.

MasterPlex® EX www.miraibio.com
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CHAPTER?2
INSTALLING MASTERPLEX®

2.2

Installing MasterPlex®

1. Insert the MasterPlex® CD-ROM in the workstation computer
= The installation guide begins automatically and the InstallShield Wizard
appears (Figure 2.1).

HI:]* MasterPlex - InstallShield Wizard

Welcome to the InstallShield Wizard for
MasterPlex

| The Instalishield{R) Wizard will install MasterPlex on your
| computer, To continue, dick Mext,

WARNING: This program is protected by copyright law and
international treaties,

=]
L

aick [ Mext > { [ Cancel J

Figure 2.1 InstallShield Wizard, Welcome screen

2. To continue the installation, click Next.
= The destination folder confirmation window appears (Figure 2.2).

MasterPlex® EX  www.miraibio.com
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INSTALLING MASTERPLEX®

HI:]* MasterPlex - InstallShield Wizard

Destination Folder
Click Mext to install to this folder, or dick Change to install to a different
i j Install MasterPlex to:
C:'Program FilesHitachiSoftMasterPlex!,
[ < Back ]|, Mext = i [ Cancel J

Figure 2.2 Destination Folder screen

To specify a different destination folder, click Change, choose the folder,
and click Next (Figure 2.2).

3. To continue, click Next.
= Custom module setup window appears (Figure 2.3).

MasterPlex® EX  www.miraibio.com
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INSTALLING MASTERPLEX®

HI:]* MasterPlex - InstallShield Wizard

Custom Setup

Select the program features vou want installed.

Click on an icon in the list below to change how a feature is installed.

Feature Description

=l =1 [MasterPlex
S The application platform

v QT v4,0
i (=0 = | ReaderFit

This feature reguires 10449KE on
your hard drive. It has 3of 3
subfeatures selected. The
subfeatures reguire 2924¢E on
vour hard drive,

[ < Baick ]L Mext = J [ Cancel J

Figure 2.3 Module selection window

4. Make sure the module name you purchased and click ==l icon you don’t
want to install.

|.!I.||Illl'l'|-| o - |neial#sield Wisard

|'.!'.I|u|rl'|-l o - Ineiall#sinld Wisard

Tustom Setup
Sabact b progren Fasture pou vt nskeled.

Tusioms Felug
Saelact the progren Fastunes pou rent rtsled.

ik o mn iconin Hs et bakow o changm how s Fasturs o reteled . ik on sniconm s bist balow o changehow s Ffasturs o rekeled .
— Fasiurs Deayipian P [eaiphon
= | M = i&- PlestegFies
MastarPlac Puicf® VastarPlar Puaderfe
= =]
== o
& MhisFasture vl be retaled oniocsl hard drive. | N = - X
EIE Thrfasus, snd o misfastunes, vl bsmibsb on kol bad divvs, E_V e Iekirs R
woir hard grive,

et P wll ik B araslalils

| relp | [ cpam || <ok J| wexx ][ coad | ek ] =osck [ wees ][ comewd |

Figure 2.4 Install module selection window

MasterPlex® EX  www.miraibio.com

6



CHAPTER?2
INSTALLING MASTERPLEX®

5. To continue, click Next.
= The Ready to Install the Program window appears (Figure 2.5).

HI:]* MasterPlex - InstallShield Wizard

Ready to Install the Program
The wizard is ready to begin installation,

Click Install to begin the installation.

If you want to review or change any of vour installation settings, dick Back. Click Cancel to
exit the wizard.

[ < Baick ]|, Install { [ Cancel J

Figure 2.5 Ready to Install the Program window

6. Click Install.
= The Start Copying Files window appears (Figure 2.6).

MasterPlex® EX  www.miraibio.com
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INSTALLING MASTERPLEX®

HI:]* MasterPlex - InstallShield Wizard

Installing MasterPlex

The program features you selected are being installed.

Flease wait while the InstallShield Wizard installs MasterPlex, This may take
geveral minutes,

Status:

[-l---l--l-l--------l-l--l---llllll---- ]

Mext 2 Cancel

Figure 2.6 InstallShield Wizard, Start Copying Files window

7. After the installation is completed, the InstallShield Wizard Complete
window appears (Figure 2.7).

MasterPlex® EX  www.miraibio.com
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INSTALLING MASTERPLEX®

|;1 MasterPlex - InstallShield Wizard

InstallShield Wizard Completed

| The Instalishield Wizard has successfully installed MasterPlex,
Click Finish to exit the wizard,

Figure 2.7 InstallShield Wizard Complete window

&. Click Finish to finish the installation and close the window.
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INSTALLING MASTERPLEX®

2.3
Installing a License

1. Double-click the MasterPlex® icon E’i‘i on the workstation desktop.
= The License Information dialog box appears (Figure 2.5).

Product Mame: MasterPlex EX 2010 version 2.0.0 Build 1
Machine 1D of this PC:

{+ Stand-alone Licenze Mode

User Mame:

Ikmstitute:

Divigion:

Date |zzued:
Licenzed Yersion:

E spiration D ate:
Licenzed Machine 1D:

Obtain Dema License... ‘ Install License File

Obtain Product Licensze... ‘

Pleaze zend an email with the zaved Licenze Request File attached to the following email
address:

1eqister@miraibio. com

" Metwork, Client Licenze Mode [Requires MasterPles network license semer)

Licenze Server IP Address:
License Server Portd:

Server Mame;

License Expires: 5

3 _Relesse licerse |

| | | Cloze ‘

Figure 2.5 License Information dialog box

2. To view instructions on how to obtain a license (*.lic), click Obtain
Product Licenses.

3. After you have obtained a license, click Install New License.
= The Open dialog box appears.

4. Use the Open dialog box to locate the license (*.lic) and double-click the
file.

= The license i1s installed.

MasterPlex® EX www.miraibio.com
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GETTING STARTED

TR 3 | Getting Started

This chapter provides a brief overview of data analysis using MasterPlex® EX.
It also explains how to start the software, import a Luminex® 100/200 or
BioPlex results file (.csv, .xls or .Ixd), and the user interface components.

3.1
Overview of MasterPlex® EX Analysis

MasterPlex® EX software analyzes results files (.csv, .xIs or .Ixd) from the
Luminex 100/200 or BioPlex system. The analysis steps include:
Import a Luminex results file (.csv, .xls or .Ixd)
Designate well types (control, treatment or background) and well groups
Attach housekeeping gene status to the analytes
Associate or /ink a control group set to an treatment group(s)
Normalization and compute fold change
Save the Luminex results file in MasterPlex® EX file format (.mlxe).
The .mlxe file includes information associated with the file (for example,
well definitions and calculated results)
After the fold changes are calculated, you can:
View the results in graphs or several different report formats
Create a virtual plate (a simulated microtiter plate) that contains data
from user-selected actual plates (.csv, .xls, .I1xd or .mlx)

MasterPlex® EX www.miraibio.com
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GETTING STARTED

3.2

Starting MasterPlex® EX

« On the desk top, double-click the MasterPlex® icon é“g . Alternatively, you
can click the Windows start menu button and select Programs
> MasterPlex 2010 > MasterPlex 2010.

= The MasterPlex® user interface appears and lists up all detected modules
in the application pane (Figure 3.1).

You can import a Luminex® or BioPlex results file (.csv, .xls or .Ixd) or
create a virtual plate from this interface. For more information on virtual
plates, see Chapter 4 Section 4.7 Creating a Virtual Plate.

& MasterPlex - B X

Windows Tools Help | Look And Feel

MasterPlex EX

App"cation m

Module

Pane

Ready Loggedanas | .

Figure 3.1 MasterPlex® user interface
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3.3

Importing Luminex® Results

To begin a MasterPlex® EX analysis, import a .csv, .xls or .Ixd file from the
Luminex 100/200 or BioPlex system using toolbar, menu bar or application
icon.

:I!. NOTE: The Luminex default directory is named Output.

Importing Luminex Results Using the File Open Menu, File Open
Icon or Application Icon

1. Choose File > Open, click the File Open icon Lj or click the application

= The Open dialog box appears (Figure 3.2).

icon

2. Enter the file path for the .csv, .xIs or .Ixd that you want to import.
Open

Look in: | ) examples v O 2 o m-

My Recent @ILS.CSV
Documents

Deskiop

Wy Documents

e
My Computer
My Network Files of type: | Data Files {".cev: ~xds: ~led; ~.mbe™) v

Figure 3.2 Open dialog box

MasterPlex® EX www.miraibio.com
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3. Navigate to the directory of the .csv, .xls or .Ixd that you want to import.

4. Select one or more .csv, .xls or .1xd files and click Open.
To select adjacent files, press and hold the Shift key while you click the
first and last file in the selection. To select nonadjacent files, press and hold
the Ctrl key while you click the files of interest.

= The EX module window opens and displays the results data (Figure 3.3).

[ S T | raaeslpremnon l0pEess ) X

[ |

530 e e N [l | g
sl uu B BRSO
L 1§ 3 4 -] a T .} L] i] 11 2
1180 .0 il J1060 rd 0 1 105 L3} L8] S1EEE
A : : ;
pr} 1 14 157 brrs | 176
i 1oty 5 1280 anl | 2y T PE | 5500 | e
‘ i = =T e o) 1 1 T ] 111
F |
‘H-‘iﬂ e 3] | T Lt 4 100 iM L1 1L 0.0
r ; y
e . a 1K L pLL] L £
i FEL ] 2§ ] 7 2 5 a0 m
1450 i 100 | s ] A | ERE0 | am
L i ml sz 1 219 184 =4 | F4
B0 |28 L] LA FLEN ] im b 28] Iin
= = ;
gl 7 ) i 14 15§ L3 13k
- LU R T 140 ET Tt r M| 30 1]
o} 1 ik 114 ol Fel fras ] 143
= 110 1531 10 S 4100 I 1173 i
=] 2| M | in b m au i
FLEC Y 7 L s 414 Il s iH
f L 184 Ly 1H riL | i 18 187
Baasdy b friam I
Analytes Plate View
Pane

Figure 3.3 Plate tab displaying results data
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3.4

Import .csv, .xIs or Open .Ixd, .miIx* Files by drag and drop

1. Open Windows Explorer and adjust the window size so that you can view
both the MasterPlex® EX and Windows® Explorer application windows.

2. Use Windows Explorer to navigate to the .csv, .xls, .Ixd or .mlx file(s) that
you want to open.

3. Select the file(s) of interest, then click and hold the mouse button while you
drag the selected file(s) to the MasterPlex® application menu bar area
(Figure 3.4).

To select adjacent files, press and hold the Shift key while you click the
first and last file in the selection. To select nonadjacent files, press and hold
the Ctrl key while you click the files of interest.

4. Release the mouse button.
= The file(s) open in MasterPlex® EX.

| |
m Fle EdL Vs Fowdrs Tods  beo |
ek - L) T e | f raeda | ] |

res | 0P e Rl FHLE NG PPl 1 2 i eeme | “ Bw
Fokda's T I Tt Ha i
B ) MechevPle 6T -~ pragesid sy | AFD WrosofE ool Conves Sepe 137 LAIEI0E #30 P
M 0T 20 i e 199D Meroso  Eerel Coms S . INZHZI0L 423 20
L dan Lo D Moot v Cormea e, . YEOOHI 1590 P14
e =T iZIA PO P 1 L0031 e
i mapwipier
51 HIM. tks Workshan
B (oo Tnetal Zhisld [Imilsletior il
Uunsh £ 2] nisleue
H 5 hiwmet Elonr
H L krka's
H I Likaryn

L) Mamimrgar w
| *

Figure 3.4 MasterPlex® EX and Windows® Explorer application windows
Use a drag-and-drop operation to open a .csv, .xls, .Ixd or .mix file(s) in the
MasterPlex® application menu bar area
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3.5
Tab categorized work flow

EX application module consists of five tab pages, Plate Map, Dashboard,
Data, Charts and Export (Figure 3.5), designed to match the work flow in a
typical multiplex data analysis session.

Figure 3.5 EX application module tabs

Define a Plate

- Mark sample as
Background, Treatment
or Control
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&
&
&
F %
oy
4
L
&
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- Define Housekeeping
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{

Check data distributions

and calculate fold change || :-“-.ﬂ_ E.,...Tm rr—r—
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Review Data

Review all data

Print or export the data

Review Data by Chart

Review all data on the
chart

Customize chart
properties

Print or export the chart

Export Customized Data

Transform the
MasterPIex®QT xml
data to original data
format

- Import or export the
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3.6

Viewing Data in the Plate Tab

The EX application module starts in the Plate Map tab. If any other tab page is
displayed, click the Plate Map tab to display the Plate Map tab as shown
below(Figure 3.6).

Plate Map tab
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Figure 3.6 Plate tab page

1. If more than one application window is open, select the B Cascade,
H Tile Horizontal , or [T] Tile Vertical menu from the window menu bar
to arrange the application windows for easier viewing.
2. To change the data displayed in the well grid:
a. Click an analyte in the Analyte pane.
b. Make a selection from the data type upper drop-down list.
= The well grid displays the data for the selected analyte.
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Figure 3.7 shows the components of the Plate tab. Table 3.1 lists the types
of data available for display in the plate view.
3. To view background-subtracted data, click the Subtract background

button

= The Plate tab displays background-subtracted data.
For more information on background calculation options, see Background

Type on section 4.6.

Data type ‘upper’ and ‘lower’ drop-down list

Lower grid switch

Display box

Subtract Background button

Sample marking icon /

Command icon
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Figure 3.7 Plate tab and Analyte pane
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Plate View Components

Well Grid A representation of a microtiter plate that displays
the well contents for the analyte selected from the
Bead Set panel and data type selected from the
data drop-down list. Some data types can be
edited (see Table 3.1). Select one of the wells (The
wells turn gray), then click the same well once
again to edit mode.

Data type ‘upper’ Shows the types of data available for display in
and ‘lower’ the well grid. Make a selection from this
drop-down list drop-down list to choose the data type displayed

in the well grid. Click the drop-down arrow to
view the list and select a data type. (See Table 3.1
for a description of the data types.) The well grid
can be separated into upper and lower grids by
clicking lower grid switch. (See Figure 3.8 for
more further details)

Lower grid switch Enables the lower grid data selection and display.

Display box Displays the selected data type value for the
active (selected) well.

Analyte pane Displays a list of the analytes (bead sets) in an
assay.

Sample marking icon Icons for sample marking.
Subtract background Displays the background-subtracted value.

Command icon Icons for operating plate tab.
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Table 3.1 Data Types in the well grid

Data Type Description Edit
Data

MFI (Median The median fluc()@rescence intensity measured No

Fluorescence by the Luminex ~ 100/200 or BioPlex system for

Intensity) a bead set count.

Count The number of beads (per bead set) detected | No
by the Luminex® 100/200 or BioPlex system
(specified by the user in the Luminex software).

Sample Amount The sample’s amount. Yes

Outlier A check mark indicates the well is outlier and Yes
the well data are not included in the calculation
of concentrations.

Normalized MFI Shows calculated normalization value No

Fold Change Shows calculated fold change value No

Sample Name User-specified name for the well. Yes

Group Name The group number of the well. Wells that Yes
belong to the same group have the same group
number.

Link Group Shows the control group number that is linked | Yes
to each well or well group.

MFI Average Shows the MFI average within the group. No

MFI Stdev Shows the MFI standard deviation within the No
group.

MFI %CV Shows the MFI %CV within the group. No

N-MFI| Average Shows the Normalized MFI| average within the | No
group.

N-MFI Stdev Shows the Normalized MFI standard deviation | No
within the group.

Fold Change Shows the Fold Change average within the No

Average group.

Fold Change Stdev Shows the Fold Change standard deviation No
within the group.

Intensity Shows the Normalized data within the group. No

(This data type is available in the lower drop-
down list only.)
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Display Double Data Information in one Cell

MasterPlex® EX has an unique feature for data viewing on the well grid. You
can select two data type from various kind of data, and it is displayed in the
one cell separated into upper and lower. Figure 3.8 shows how to display the
double data in one cell.

3 3° P Rl [

MFI o MFI -
— | Count -
MFI - 20.00
Count - |
1 2 3 1
20.00
A SN 20,010 <= MFI
B 13DE:: T o a E3 <:| Count

1084.50 82.00 kil

Figure 3.8 Upper and lower grid display
Well grid can be separated into upper and lower grid. Each grid displays separate

data type.
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3.7
Saving Plate Data

After you import a Luminex results file (.csv, .xls or .1xd), the data can be
saved to a MasterPlex® EX file format (.mlxe). The .mlxq file includes all data
associated with a plate such as well definitions and computed (interpolated or
extrapolated) concentrations.
To save results data (.csv, .xIs or .Ixd) to a MasterPlex® file (.mlxq):
1. Click the Save button H . Alternatively, select File > Save from the main

menu.

= The Save As dialog box appears (Figure 3.9).

Save As
Save in: _;l SampleDiata _" Q ? »
- :
59
Ity Recent
Documents

Deskiop

My Cocuments

ok
_*-!J
My Computer

Q@ e | v
N 3 S
My Network | Saveastyps: | EXve.Dfles - mixe) v/

Figure 3.9 Save As dialog box

2. Confirm the default directory where the file will be saved or choose another
directory.

3. Enter a file name and click Save.

Opening a MasterPlex® File (.mlxe)

1. Click the Open button =3 Alternatively, select File > Open from the
main menu.
= The Open dialog box appears (Figure 3.10).
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Look in: | ) examples
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® [

IL5 Project.mlx
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B H 10Plex. csv
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File name: ||

g |

Files of type:

(™.mbe; ~hed; ~ads;

~.cav)

v| [ Cancel ]

Figure 3.10 Open dialog box

2. Confirm the default directory or choose another directory.
3. Select a file name (.mlxq) and click Open.
= An application module window opens and displays the results data

(Figure 3.11).
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Figure 3.11 Plate Map tab
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4 | Defining a Plate — Plate tab
After you import a Luminex results file (.csv, .xls, .Ixd), your analysis begins
by defining a plate. This chapter explains how to define and save a plate. The
steps to define a plate include:
Designate well type to identify the standard, unknown, background,
and control wells.
Attach Housekeeping gene status by right clicking on the analyte pane.
A plate can have more than one housekeeping genes.
Link each well group to a control group to specify the control that is
used to compute the analyte fold changes.
The plate definition can be saved as a template that can be applied to other
plates. The Template Manager helps you manage your templates. For more
information on templates, see Working With Templates (on section 4.5).

4.1

Designating Well Type and Group

Selecting Wells
To select a well in the Plate tab, click the well in the well grid. There are three
ways to select multiple wells:
To select adjacent wells (Figure 4.1), press and hold the mouse button
while you drag the pointer over the wells that you want to select. Click
and release the mouse button to select the highlighted wells.
To select adjacent wells, press and hold the Shift key while you click
the first and last well in the selection.
To select nonadjacent wells (Figure 4.2), press and hold the Ctrl while
you click the wells.

MasterPlex® EX www.miraibio.com
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Figure 4.1 Well grid

To select adjacent wells, press and hold the Shift key while you click the first and
last well in the selection. Alternatively, press and hold the mouse button while you
drag the mouse over the wells of interest.
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Figure 4.2 Well grid
To select nonadjacent wells, press and hold the Ctrl key while you click the wells of

interest.
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Designating Well Type

Table 4.1 shows the types of wells that are available.

1. Select the well(s) that you want to define.

2. To define (or mark) the well(s), click one of the icons located on the upper
well grid (Figure 4.3). You can also right-click the selection and choose a
well type from the pop-up menu that appears Figure 4.4. (Table 4.1).
= The well type is applied to the selected well(s).

BRERTIX

Figure 4.3 Sample mark icons
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Figure 4.4 Well grid pop-up menu
Right click a well to display the pop-up menu
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Table 4.1 Sample mark icon and context menu to define wells

Well Type Button | Context menu on the well
grid

Background 1 1 | Background

Wells that contain no analytes. u

Control Control

Wells that contain analytes that function as

controls for a particular assay design. —

Treatment L | | Treatment

Wells that contains analytes of unknown “

concentration.

Unmark [ 1 | Unmark

Clear the current marking. u

:I!- If a well belongs to a group, unmarking the well also removes the
well from the group.

3. Repeat step 1 and step 2 to mark and group other well(s).

Designating Well Groups
After you have defined the wells, the wells are organized into groups
automatically so that the software can identify:

Replicate unknowns
MasterPlex® EX automatically places all background wells into one group.
You can define one or more groups of control wells per plate.
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28




CHAPTER4
DEFINING A PLATE

:I!. NOTE: A group can include nonadjacent wells. A plate can have more than one
group of controls or unknowns.

Grouping Wells by Pattern

The purpose of pattern grouping is to provide users another way to easily and
quickly make replicate groups. Pattern here means two things: the group type
(e.g., control, unknown...) and the dimensions of the group (i.e., rows and
columns). This function acts similarly to the Resizing feature of Microsoft
Excel. It is especially useful when the plate has many groups/replicates that
follow similar group patterns.

1. Define the group pattern by selecting a group of wells, and marking and
grouping them together. We will group other wells into this pattern.
2. Select all wells of the pattern group(Figure 4.5).
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Figure 4.5 Well groups
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3. Move the pointer to the bottom-right corner of the selection. When you see
the pointer turn into a black cross, hold down the left mouse button and drag
the pointer over the selection. During dragging, you will see in real-time that
new wells are selected and grouped into the pattern, as indicated by a red-line
border (Figure 4.6).
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Figure 4.6 Well groups
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4. Once you are satisfied with the selection, just release the mouse button. The
software will automatically finish the grouping(Figure 4.7).
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Figure 4.7 Well groups

:I!. NOTE: When starting drag, you can move the pointer, you can move it either
downwards or rightwards, which results in different ways to select wells. To switch
between the two modes, just drag the pointer back into the pattern group, and then
drag it out in either direction. So, it is determined by your first move direction when
you are dragging the pointer out of the pattern group.
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Figure 4.8 Well groups
Dragging downwards as the first move (above) vs. dragging rightwards as the first
move (below)
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Select all wells within the group at one time
1. While hovering over a replicate group border, the mouse pointer changes to
a ‘hand’ icon (Figure 4.9).

6.00 | 10034.50 56.00 4911.00 10 6.00 | 10034.50 56.00 4911.00 il

2.00 6299.00 39.00 5011.00 a! 2.00 6299.00 39.00 5011.00 a!
[ = U

4.00 2990.50 41.00 5591.00 398 4.00 2990.50 41.00 5591.00 398

0.00 1094.00 45.00 3070.00 1804 -0.00 1094.00 45.00 3070.00 1804

2.00 300.00 39.00 1129.00 11 2.00 300.00 39.00 1129.00 i

Figure 4.9 Mouse pointer changes to ‘hand’ icon

2. Click the border while mouse pointer is hand icon.
= Entire wells within the group are selected (Figure 4.10).

.6.00 § 10034.50 66.00 4911.00 im
i2.00 6299.00 39.00 5011.00 6!
1)

14.00 2990.50 41.00 5591.00 398!

t0.00 1094.00 45.00 3070.00 1804

|
12,00 300.00 39.00 1125.00 11!

Figure 4.10 Selected wells
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4.2

Setting Sample Amount

If you want to use sample amount index to confirm your MFI values are
correctly gathered, use the auto fill feature to help you automatically enter the

sample amount.

1. Click the Auto-Fill button |} located above the well grid.
= The Auto Fill dialog box appears (Figure 4.11).

Auto Fl b 4
Dilution Parameters
Analyte All =
Target Wells Stdool -
Highest Value 10000, 000
Dilution Factor 2,000
Unit pgfmL =
Replicate Options
Replicate Number Mone =
Replicate Orientation
Detailz Dilution Direction
L mEE
| . . J o=
A | @ @@ @ III “. I —
! all all ." | -
B | @ | @ @ | @ <. 1
| | | il I > .—..
c | ¥ | @ ¥ | @] |le= [_L =
@ | ® | @] e I_I e
0 | @ | @ © | @] |s e
| Fill & Close | | Apply & View | | Close |

Figure 4.11 Auto Fill dialog box
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2. Make a selection from the Analyte drop-down list.

3. Enter the starting value for the sample amount.

4. Enter the dilution factor.

5. Make a selection from the sample amount unit drop-down list or input the

unit from the keyboard.

6. To select a dilution direction for the selected wells, click a dilution direction
arrow.
= The gradient map shows the location and direction of the dilution

gradient(s) (Figure 4.12).

1 | 2 2 | 4 In [ I =
A .® @ @ ® | [mewl Iz =) E Click an arrow to
oo oo WIS womsome
ARIRIRAR = 2] =
o @ @ o ol EH]=

This gradient map specifies a separate dilution gradient in each
column of the selected wells. The starting value is at the top of a
column.

ce e S
A (v rv_i-v — —
o000 il s
| ®iIQI®|® ==
» | @+ @4 @- @ | ] 1] (=]

This gradient map specifies selected wells. The starting value is at
the upper left well and the end concentration is at the lower right well.
Click an arrow to choose a dilution direction.

Figure 4.12 Example dilution gradient maps
Click a dilution direction arrow to choose the dilution gradient configuration for the
selected wells.
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7. To specify the same starting value, dilution factor, and units for all analytes
in the standard data set, choose the Fill for all analytes option. To specify a
different starting value, dilution factor, or unit for a different analyte, repeat
step 2 through step 4.

8. Click Apply button when finished entering the sample amount value, the
dilution, and the dilution direction for all analytes in the selected wells. If
you want to close the dialog box at the same time, click Fill & Close

button.
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Fill in for replicate samples

If you have replicate samples in your plate, and if you want to fill the same
diluted sample amoount value for each replicates, use replicate filling option
(Figure 4.13). Figure 4.14 and 4.15 shows each ‘Side by Side’ and ‘Stacked’
replicate example.

Auto Fl b 4

Dilution Parameters

Analyte Al ~
Target Wells Stdool -
Highest Value 10000, 000
Dilution Factor 2.000
Unit pgfmL =

Replicate Options
——— Choose Replicate Number from 2to 5

-t

-

Replicate Number

Hspheate Urentabum I| T~ If replicate number is selected
iaked - g (other than ‘None’), ‘Side by Side’
Dietails | Dilution Direction ' and ‘Stacked’ are selectable..
SRR BRI | 7113 e
A @@ @@ III] II [
! -1 -1 a w L&
B | @ | @ @ | @ . ,
} il il = I.'- .'_‘..
c | ¥ | ©|® | @ [l l=
SR = | | =
| Fill & Close || Apply & View || Close |

Figure 4.13 Replicate Options
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Figure 4.15 Stacked Replicate Options
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Input Sample Amount value Manually
If your sample amount series does not have sequential diluted values, use
direct edit mode on the well grid(Figure 4.16) .

15.00

= TR I o T

=

Il

Qutlier
Mormalized MFI
Fold Change
Sample Mame
Group Mame
Link Group

MFI Average
MFI Stdewv
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M-MFI Stdewv
Fold Change Average

1

1163.00

1230.00

289.50

!| 284.50

‘ = -

Set data type as sample amount in the

upper or lower

Click one of the
well you want to
input the value.

64.00 f

dropdown list.

g
0.00] 11340} 00

= | §= G

Click same well again, Input the value.
press character key or

press F2 to enter the

edit mode.

Figure 4.16 Input manually using edit mode

G

0.00 [

0.00 [

Sample amount is shown in the well grid.

11340.00

Click other well,
enter key or
ESC key to exit
the edit mode.
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4.3

Linking a Control Group

Treatment wells must be associated with or /inked to the control group that
will be used to calculate fold changes. By default, the first control group that
you define will be linked to the treatment well groups.

If there 1s more than one control group on the plate, you can link a
user-selected control to a user-selected well group(s).

1. To link a well group to a control group, press and hold the Ctrl key while
you click the group and the control group that you want to link.

"'-IJ' NOTE: A control group can be linked to multiple groups of the same well type, but
each group can have only one control group.

2. Click the Link One vs. Multi button E :
3. To check the status, select Link Group data type from upper or lower
drop-down(Figure 4.17).

Link Group - =i - - . — . -.
Uuuuw B E00
3 4 5 5 7 :

1 2

a ID Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1
: Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Cctrl 1
z Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1
. Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1
: Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1
= Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Ctrl 1 Cctrl 1

Figure 4.17 Display linking status
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4.4
Attach Housekeeping Gene Status

If you need to set housekeeping gene status to some analyte for normalization,
you can attach the housekeeping gene status to the analyte.

1. Right click on the analyte name you want to add ‘housekeeping gene’ status
in the analyte pane.

= Context menu appears (Figure 4.18).

ﬁ\ oL g House Keeping Gene I

& cxcLe Rename: |ACTB
e GAPD T T T

& 1cam '| 1280.00 |

Figure 4.18 Context menu for analyte pane

2. Select ‘House Keeping Gene’ menu from the context menu.
= Analyte icon in front of the analyte name turns red to green (Figure 4.19).

. . : — 1
& co House Kesping Gene b —r

& oxcLe Rename: |ACTE } ;; & cxcLe A - lies.oo g
Ace Y T T & carD 202
@1::.:«41 l 1280.00 I e&\lcmvu | o I

Figure 4.19 Attach housekeeping gene status

3. Repeat step 1 and 2 until all house keeping genes have housekeeping gene
status.
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4.5
Flagging the data

If you need to set outlier flag due to our of range results, you can flag the data
as outlier.

Set outlier flag manually

1. Select ‘Outlier’ data type from upper drop-down list or lower drop-down
list (Figure 4.20).
= Current outlier status are shown in the plate well grid.

Outlier - u i
: «

Figure 4.20 Display outlier status
2. Select a well you want to flag = click same well to enter the edit mode =

click once again to make a check = select other wells to exit the edit mode
(Figure 4.21).

N =2 K =3 .

Figure 4.21 Flag the data manually

N =

Set multiple outlier flag using batch flagging feature
2. Select multiple wells you want to set the dilution at one time(Figure 4.22).
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Outlier - false | o
B PC
3

4

Figure 4.22 Flagging outlier

2. Right click on the well grid.
= Context menu appears (Figure 4.23).

1 2 3 4 5 &) 7
A
A hspirate
B
i
I.lm Mark Wells r
5 u Inmark.
E
") Plate Dilution
Bt ; & Setfor all analytes
b O & Plate Cutlier — »f & B
&
1 Serle TS % & Set for current analyte -
Group Names & Unset For all analytes
3

IUnset for current analyte

Figure 4.23 Batch outlier flagging menus

3. Select Plate Outlier menu. Sub-menu appears (Figure 4.23).
4. Select one of the sub-menu to flag the data.
= Check box status is changed by the selected menu (Figure 4.24).
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Figure 4.24 Flagged out data
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4.6

Working With Templates

A plate definition includes:

Well types and well groups

Housekeeping gene status

Links between the control(s) and well groups
Data calculated for the plate (for example, normalization MFI or fold

changes)

Data manually entered in the plate (for example, sample names or sample

amount)

You can save the plate definition as a template. You can apply a template to
an active plate. Templates may also be exported, imported, or deleted.

Opening the Template Man

ager

The Template Manager is a tool that helps you manage your templates.

1. Click the Template Manager button f;\_?; :

= The Template Manager appears (Figure 4.25).
2. Click a template in the Available Templates list to view information about

the template.
Template Manager
| | |
£ Human 10plex MName:  MEplexSinglestd
=z MSPlexSingleStd
[ Created by:
Creation date! |g/3/2008
Creation time! |g:53:45 pm
Description: | Mouse 5 plex
Single standard set
| |
| Load | | Save
[ Bport o [ Import
| Owverwrite | | Delete
| Close |

Figure 4.25 Template Manager shows available templates
Click a template to view information about the template.
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Saving a Template

You can save the current plate definition to a template.

1. After you have finished defining a plate, open the Template Manager and
click the Save button.

= The Template Name and Description box appears (Figure 4.26).

x

Mame:

Description: il

K Cancel

Figure 4.26 Template Name and Description box

2. Enter a name and descriptions for the template and click OK.
= The new template is added to the Available Template list.

Loading a Template
You can apply or load a saved template to the current plate.
1. In the Template Manager, select the template that you want to apply to the
plate.
2. Click the Load button.
= The template is applied and the well grid shows the new well attributes
(well type, well group, and links to standard data sets).

Overwriting a Template
You can overwrite an existing template with the current plate definition.
1. In the Template Manager, select the template that you want to overwrite
2. Click the Overwrite button.
= A confirmation box appears (Figure 4.27).
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4
E

Wyarning

L] E Are you sure you want to overwrite M5PlexSingleStd'?
P}

Figure 4.27 Confirmation box

1. Click OK to overwrite the selected template with the current plate
definition.

Exporting a Template

You can export a template to a user-specified location.
1. In the Template Manager, click the template you want to export.

2. Click the Export button.

= The Save As dialog box appears (Figure 4.28).

'.a.:
My Recent
Documents

L&

Deshiop

My Documents

My Computer

-

Iy Metwaorl

Save As E| g|

Save in: | | examples o | ¥ £® '
[ysample name empty
Cldata
File mame: | b | [ Save ]
Save as type: l[v]asterP_I.?i'DaTPEg {*.metg) w ! [ Cancel ]

Figure 4.28 Save As dialog box

3. Choose the directory for the template that you want to export.
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4. Enter a name for the template (*.mxte).

Ij- NOTE: A template must have a .mxte file extension. Changing the extension will
render the exported template unusable.

Importing a Template
You can import a template (.mxte) from a user-specified location.
1. In the Template Manager, click Import button.

= The Open dialog box appears (Figure 4.29).

Look in: ||jexamples M & ¥ o -
Y [J)sample name empty
[ ) Chdata
My Recent

Documents

My Documents

48

My Computer
‘r_? File mame: || | Open
b I =
My Metwark Files of type: | MasterPlex Template {"modq) w !

Figure 4.29 Open dialog box

2. Choose the directory with the template that you want to import.
3. Select the template and click Open.
= The template name is added to the Template Manager.

Deleting a Template

You can delete a template (.mxte) from the system.

1. In the Template Manager, click the template that you want to delete.
2. Click Delete button.
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= A confirmation box appears (Figure 4.30).

WWarning x

L] E Are you sure you want to delete MEPlexSingleStd'?
*

e OK | | Cancel

Figure 4.30 Confirmation box

3. Click OK to delete the template.

= The template is removed from the Template Manager.

/|\ WARNING: This permanently removes the template from the system.
L]

WARNING
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4.7

Preferences

Preferences are user-modifiable software settings. They are displayed in the

Preferences dialog box.

* To open the Preferences dialog box (Figure 4.31), click the Preferences
button 2% .

There are two preference tabs

Application Application specific preferences. Preferences in this tab are
applied to all files being opened on the EX module.
Plate Plate specific preferences. Preferences in this tab are

applied to current being opened file.

.......

Figure 4.31 Preferences dialog box

Application preferences
Split Cell Color
Color lower grid by specified color (Figure 4.32).

1 2 3 4

41.00 39.00 37.00 | 112.00

" 189 104 103 226
10516.00 | 10034.50 66.00 | 4911.00

g |,io00) 100890 . 5600 Atdd
208 152 199 203

615200 | 6299.00 39.00 | 5011.00

I: --------------------------------------------------------
225 246 247 220

Figure 4.32 Colored lower well grid
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Intensity Color
One Color Use Bead Count value for threshold conditions.
Two Color Use Error Range for threshold conditions.

1 2 3 + 5 3 7 8 E 10

1000 900 | 1900 520300 | 4850 | 116200 | SS73.00 | 214500 #4300 187.00
B One color [ LimeGresn - 9929.00 | B969.50 | 699400 448700 6400 | 170.00 | 479600 | 100500 20850 | 95.00
’ [ |
|:> ses0s0 | se7e0 | w2en0 | aweno|  w7s0|  1s00| ;im0 | 77zs| wen0| 500
¢
") Two colars =]
265600 | 304800 | 6350 | 327700 | 139600 | 10900 | 195700 | 646700 | 4300 3200
o
110450 91400 | 5750 | 150100 184200 138.00 | 723300 | 553550 2750 185.00
£
30000 | 40400 | 139600 43300 13350 1500 | 624750 | 372750 | 1500 9900

Click ‘one color’ and select desired color for ;
the maX'mum Value. The CO|OI’ denSIty . 14350 | 11500 | 745300 | 6100  58.00 | 7190.00 | 4678.00 | 264050 77900 70.00
decreases dlrectly Wlth the Value e 42.50 4000 | 7817.00 | 3178.00 5450 | 730000 | 362550 | 166250 |  343.00 3100

| 1 2 3 4 5 6 7 8 £l 10
10.00 5.00 19.00 | 6903.00 48.50 | 116200 | SS573.00  2145.00 | 443.00 | 187.00
gl 1 0 0 0 I I | |
Cnie colar = N A 6400 | 179.00 | 474600 100500 20950 95.00

I:} 5850.50 | 5807.00 | 1207.00 | 4276.00 37.50 18.00 | 327100 | 772250 104.00 45.00
| 0 I I I | |

Upper I 255, 0,0 - , |2 sa 63.50 | 3277.00 | 1846.00 | 10300 | 1957.00 | 6467.00 4300 32.00
Lawer 0 s - 110450 81400 | 5750 150L00 | 184200 138.00 | 723300 553550 2750 | 185.00
W Uy B
30000 | 40400 | 139600 | 43300 | 13350 | 15.00 | 624750 | 372750 | 1500 | 9%.00
-
ick lors’ and select desired color for th
C“Ck two colors’ and select desired color for the 14350 | 11600 | 745300 | 6LOD | 5800 | 7180.00 | 487800 | 2840.50 | 77900 | 70.00
maximum and minimum value. The color shifts
4250 4000 781700 317800 5450 | 730100 362550 166250 34300 3100
H

upper to lower directly with the value.
Figure 4.33 Example of Intensity color

Plate Preferences
Plate Information

Original File Name Displays the name assigned to the result file in
the Luminex® 100/200 or BioPlex software. To
edit the plate name, enter a new name.

Analyst Name Displays the analyst name entered in the
Luminex® 100/200 or BioPlex software. To edit
the analyst name, enter a new name.

Plate Name Shows plate name of this file.
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Background type
Average Calculate average value in the background group.
Background (Bkg) MFI = (Bkg MFI, + Bkg MFI,
+... Bkg MFI,))/n
where n = the number of background wells in the
plate
Peak Value Take highest value in the background group.
Lowest Value Take lowest value in the background group.
Outlier Options

You can select one of the criteria for threshold marker from MFI,
Concentration, Bead count and Error range. Select one of them and enter an
MFI, count, concentration or error range threshold for a plate. The software
automatically marks wells that contain data less than the user specified
threshold with a red border (Figure 4.34).
To set a threshold(s):
1. Check ‘Show threshold marker’ box
2. Check one of the radio button in front of the data type you want to use as a
threshold marker.
3. Select equity equal symbol and input the value in the box.
4. Click Apply to reflect current setting to the plate, or click OK to reflect and
close the dialog box.
= A red border marks wells that contain data less than or greater than
threshold for all analyte (Figure 4.25).
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28.00 29.00 40.50

11083.00 | 10831.00 587.00

5072.00 5899.00 58.00
C

7044.00 7087.00 63.00
D

44987.00 4440.00 95.50

2824.00 2861.00 280.00

1484.00 1451.00 2150.00

Figure 4.34 Well grid

Outlier Options
Show threshold
Marker
MFI
Count
Normalized MFI
Fold Change

Error Range

Automatic outliers

4

1022.00

5457.00

5459.00

4589.50

575.00

5 [ 7 8 9 10

126.00 1932.50 1964.00 787.00 271.00 105.00

133.50 621.50 1465.00 472.50 128.00 66.0(
201.00 62.00 866.50 5011.50 80.00 48.00
4681.00 50.00 511.00 3186.00 47.00] 38.0(

2722.00 415.00 4701.00 2289.50 41.00] 154.0(

218.50 72.00 44.00 3372.00 1472.00 30.00 89.0(
157.50 63.00 4727.00 2160.50 831.00 310.50 55.0(

Show red rectangle indicator inside the grid if the
threshold conditions meet the criteria.

Use MFI value for threshold conditions.

Use Bead Count value for threshold conditions.
Use Normalized MFI value for threshold
conditions.

Use Fold change value for threshold conditions.
Use Error Range for threshold conditions.
Automatically check on/off the outlier check box

for the wells. To check on, click Set button. To
check off, click Clear button.
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4.8
Creating a Virtual Plate

1. Open the Luminex results files (.csv, .xls or .Ixd) or MasterPlex® EX files
(.mlx*) that are the data sources for the virtual plate.
2. Click the Virtual Plate button 4.

= The Virtual Plate dialog appears (Figure 4.35).

\irtuzl Plate
Flate Dimensions
To create a virtual plate, please

enter the application type and the
dimensions for the virtual plate.

Type: MasterPlex EX i
Rows: 3
Columns; 12

| QK | | Cancel |

Figure 4.35 Plate Wizard, Plate Dimensions tab

3. Select an application module, then enter the number of rows and columns
for the virtual plate. Click OK.

= A module window opens and displays the empty well grid of the
virtual plate (Figure 4.36).
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G

H

Figure 4.36 Virtual plate

Selecting Data from a Source Plate

The virtual pipette copies (aspirates) data from user-selected wells in a source
plate and pastes (dispenses) the data into a virtual plate. The virtual pipette
copies all of the analyte data in a well, including the computed analyte
concentrations. It remains loaded until you dispense or clear the pipette.

"'-IJ' NOTE: The data source plates must contain the same type and number of analytes,
otherwise concentrations cannot be calculated. If the source plates contain the
same number of analytes, but they are named differently, use the virtual analyte
filter to rename analytes so that the nomenclature is consistent. (See Working with
the Virtual Analyte Filter on section 4.8.)

1. In the source plate, select the wells of interest.
To select adjacent wells, press and hold the mouse button while you drag
the mouse pointer to select the wells of interest.

"'-IJ' NOTE: Selecting non-adjacent wells is not recommended.

2. Right-click the selected wells and select Aspirate from the pop-up menu
that appears (Figure 4.40).
= The data for the analytes in the selected wells are added to the virtual
pipette and is ready to dispense into a virtual plate.
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:I!. NOTE: If the background is subtracted in the source plate, the virtual pipette
aspirates and transfers background-subtracted values. If you do not want to
aspirate background-subtracted values, make sure the background subtraction is
turned off before you aspirate data into the virtual pipette. (Click the button to
turn background subtraction on or off.)

g 2 = =
41.00 35.00 37.00 112,
A

1051600 | 10034.51 66.00 4911.

S Aspirate |
£152.0- 4%——--'%11.

3104.0 1;
(B]

Figure 4.37 Well grid
Right-click selected wells to display the pop-up menu.

[}

3. To clear the data from the virtual pipette, right-click and select Clear from
the pop-up menu (Figure 4.40).

,f Dispense
i

(o Clear
|2t A

P

Figure 4.40 Clear Aspirated Data
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Adding Data to a Virtual Plate

After the virtual pipette aspirates data from the source plate, it is ready to

dispense the data into the virtual plate.

1. Position the mouse pointer over the virtual plate.

2. Click the first well to which the data will be added.

3. Right-click the well and select Dispense from the pop-up menu that
appears.
= The data are added to the virtual plate (in the same configuration as in

the source plate) (Figure 4.41).

NOTE: If the number or names of the analytes in the virtual pipette is different from
that in the virtual plate, the virtual analyte filter automatically appears. For more
information on using the filter, see Working With the Virtual Analyte Filter on section
4.9.

:I!. NOTE: Data in a virtual plate cannot be removed, but can be overwritten.

1. Open a .mlx or .csv. | ! | |
10516.00 | 10034.50 66.00 49

2. Select the wells of interest in the source
plate (.csv or .mix). Right-click the E
selected wells and choose aspirate from
the pop-up menu.

[ % Aepirate %

6152.0

T e

3. In the virtual plate, select the first well where
you want to dispense the data. A
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4. Right-click the well and select | 1 _ 2 3 4
Dispense from the pop-up menu.

' Dispense %

f }f Clear

i_
i 2 3 4
5. The data are added to the virtual plate
(starting at the selected well) in the same
configuration as in the source plate.
10516.00
6152.00
3104.00
1040.00

Figure 4.41 Adding data to a virtual plate
Open a source plate (.mix or .csv, .xIs or .Ixd) and create a virtual plate (click the g
button to generate the blank virtual plate).
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4.9
Working With the Virtual Analyte Filter

In a multiplex assay, all of the plate wells must contain:

The same types of analytes (bead sets) with the same nomenclature

The same number of analytes
This is true for virtual plates as well. When you add data to a virtual plate,
MasterPlex® EX compares the name and number of the analytes in the virtual
pipette to those in the virtual plate. The virtual pipette will not dispense if
there are discrepancies between the number or names of analytes in the pipette
and the virtual plate. If the number of analytes in the pipette is greater than
that of the destination plate, the virtual analyte filter automatically appears
(Figure 4.42).

The virtual analyte filter displays a list of the analytes that are present in the
virtual pipette. It enables you to choose the analytes that you want to add to
the virtual plate and, if necessary, rename them to be consistent with the
number and name of analytes in the virtual plate.

If you add data to a virtual plate from source wells that contain different
analyte names or a different number of analytes, data holes are created. As a
result, a well in the virtual plate appears blank if the analyte selected in the
analyte panel is not present in the well. If a plate file (.csv, .xls, Ixd, .mlx, or
virtual) contains data holes, the concentrations cannot be calculated.

NOTE: In order to prevent data holes, if the number of analytes in the virtual pipette
is less than the number of analytes in the destination plate, the data cannot be
added to the virtual plate.
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Virtual Analyte Filter x
Mew Analytes Assign Aliases
s ..... - o
N IFM gamma Click here to assign
II-1 Beta Click here to assign
IL-10 Click here to assign
IL-2 Click here to assign
IL-4 Click here to assign
IL-5 Click here to assign
IL-G Click here to assign
IL-3 Click here to assign
THF alpha Click here to assign
| Check all analytes ] Add all as new
Ok, | | Cancel |

Figure 4.42 Virtual analyte filter shows the analytes in the virtual pipette

Selecting and Renaming Analytes

If the virtual analyte filter appears, you must select and, if necessary, rename

the analytes to match the number and names of the analytes in the virtual

plate.

1. In the virtual analyte filter (Figure 4.44), place a check mark next to each
analyte that you want to add to the virtual plate. To select all analytes for
the virtual plate, click Check All.

2. To rename an analyte so that it is consistent with the nomenclature in the
virtual plate:

a. Click here to assign next to the analyte that you want to rename.
= A drop-down list shows the names of the analytes in the virtual plate
(Figure 4.43).
b. Select a name from the drop-down list.
= The virtual analyte filter displays the new name for the analyte.
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Virtual Analyte Fiter x
Mew Analytes Assign Aliases
GM-C5F Click here to assign
IFM gamma Click here to assign
List of analytes [ Il-1Beta Click here to assign
in the virtual O |IL-10 Click here to assign
Pipette. IL-2 Click here to assign
IL-4 Click here to assign
/ T L& Mone
Place a check O 18 Add 2= new Click to display a
mark next to an O] TNF alpha 0% Mouse 110 1§ rop-down Iist @
analyte to add 054 Mouse IL-2 analyte names in
it to the virtual 073 Mouse IFM gamma the virtual plate.
plate. 077 Mouse IL-4 Sele_ct a name from
the list to rename
the analyte from the
source plate.
| Check all analytes C| add all a5 new
| oK | | Cancel

Figure 4.43 Virtual analyte filter

3. To save the renaming assignments for use again with the same source plate
(.csv, xls or .Ixd or .mlx) during the current session, choose the Save this
assignment option.

If you want to aspirate other data from the same source plate, choose the
Use last saved assignments option in the virtual analyte filter to
automatically rename all of the analytes in the filter.

4. Click OK.
= The data are added to the virtual plate and the virtual analyte filter

closes.
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4.10
Changing the Analyte Name

You can change the analyte names on plate map tab’s analyte pane (Figure
4.44).

MFI -
Count "7

:
& oLz »
& cxoLs A |
& GAPD
& 1cam1 19
& TFNG B |
& s
& MAPKE 2
& Tere1 - .

& ™F

Figure 4.44 Analyte pane

1. Right click on the analyte name you want to rename.
= Renaming box appears (Figure 4.45).

‘& coLo House Keeping Gene
& cxcLe Rename: |ACTE
.a. ARM

Figure 4.45 ﬁenaming box

2. Input new name and click out side of the box or enter return key.
= Renaming is performed (Figure 4.46).

: ‘ BT
House Keeping Gene 1 |:> ‘&
CCL2

Rename: |GAPD

& oLz
& cxcLe

A& ceen .
Figure 4.46 Renaming the analyte name
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4. 11

Quality Control Manager (optional module)

Quality Control Manager helps you flag and optionally set as an outlier any
wells whose value is outside of the range defined by the thresholds.
Thresholds can be assigned using the manual method for

- A single selected analyte

- Multiple selected analytes

- All analytes
* To open the Quality Control Manager (Figure 4.47), click the Quality

Control Manager button E .

Quality Control Manager x

] &ll analytes This tool helps vou flag and optionally set as an outlier any well whose -
value is outside of the range defined by the thresholds, Thresholds can
be assigned using the Manual method for:

Analyte
- A single selected analyte
- Multiple selected analyies
- All analytes

After each change please dick the Apply button to Save, Flagged wells B2

Settings

[C|Flag wells outside range! [C] Mark as outlier

Ul LOD [ ULOD | %CV | Exirapolated Values |

Lower Upper

[C] Response Values .

O] Calculated Values .

| Apply |

| 0K, | | Close |

Figure 4.47 Quality Control Manager dialog

The software automatically marks wells that contain data less than the user
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specified threshold with a red border (Figure 4.48).

To set a threshold(s):

1. Select analytes you want to attach the threshold criteria from the analyte
pane.
= Use All analytes check box or Ctrl key for multiple selection.

2. Check ‘Show threshold marker’ box and/or ‘Mark as outlier’ box.

3. Select the threshold criterion from the threshold tab.

4. Set threshold conditions and click apply button. Close the dialog box.
= A red border marks wells that contain data meet the threshold criteria.
= If you choose ‘Mark as outlier’ at the same time, the data are marked

as outlier and outlier check boxes are checked (Figure 4.49).

1 2 3 4 5 5 7 3 9 10

41.00 39.00 37.00 112.00 52.00 2426.50 43.00 36.00 48.00 §0.00
A

10516.00 || 10034.50 66.00 4911.00 106.50 186.00 41.00 38.00 45.50 55.00
B

6152.00 6299.00 39.00 5011.00 65.00 43.00 38.00 52.00 40.00 45.00
&

3104.00 2990.50 41.00 5591.00 3989.50 113.00 38.00 44.00 40.00 42.00
D

1040.00 1094.00 45.00 3070.00 1808.00 270.00 48.00 40.00 36.00 47.00
E

292.00 300.00 39.00 1129.00 119.00 41.00 42.00 40.00 37.00 44.00
.

R L T T N e
. .
Figure 4.48 Well grid

1 2 3 4 5 -] 7 3 9 10
A
B
C
D
E
F

=1 =1 =1 =1

Figure 4.49 Outlier check boxes
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Settings
Flag wells outside Show red rectangle indicator inside the grid if the
range threshold conditions meet the criteria.
Mark as outlier Mark flagged data as outlier

Threshold Options
Manual

Use Raw MFI, count, Normalized MFI or Fold Change value for threshold
conditions (Figure 4.50).

The wells outside

Lower Upper of this range are
flagged.
[¥] Response Values 150

|C] calculated Values r

Combination
selection is
allowed.

|- Apply

Figure 4.50 Outlier check boxes

LLOD (Lower Limit of Detection)

Flag the lower values than the LLOD calculation value (Figure 4.51). LLOD
1s based on the MFI mean value of the selected wells plus the standard
deviation multiplied by the user selected number.

[ Manual (WERSSM LiOD | °%CV | Extrapolated Vales |

Far all analytes: Select the base

[¥] Calculate LLOD MFI wells from
ok op up well grid.
|| Exclude selected wells from outlier " PoP Up 9

Select wells to be used in LLOD calculation

*

LLOD = Mean MFI of selected wells + B - | stdev

-Mi

[1

Figure 4.51 Outlier check boxes
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ULOD(Upper Limit of Detection)

Flag the upper values than the ULOD calculation value (Figure 4.45). ULOD
1s based on the MFI mean value of the selected wells plus the standard
deviation multiplied by the user selected number.

Manual TRl “iCV | Extrapolated Valies
Select the base

Far all analytes: MFI wells from
[#] Calculate ULOD / pop up well grid.
[#] Exclude selected wells From ouflier marking

.

Select wells bo be used in ULOD calculation

UL = Mean MFI of selected wells + g~ | Stdev

-

Figure 4.45 ULOD tab

%CV
Use %CV value of the group (Figure 4.52). Flag the values greater than the
specified %CV value.

| Menual | 100 | iop [IRASK

For all analytes:

[ Set %CY threshold as greater than 10,

Figure 4.52 Outlier check boxes
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CHAPTER
5

Normalization & Fold Change

- Dashboard tab

This chapter explains how to evaluate each analyte and calculate normalized

MFT and fold change.

5.1

Go to Dashboard Tab
Click Dashboard tab then application window displays the dashboard tab

page (Figure 5.1).

Dashboard tab

ST o ERETTRIETN

oacme 51 = | a3k g
, o Control Treatment MiF1 { Sampla Chart .
i L&y = 1 GemasinG Pay
iy, RN & s
F R * TR
1 S 33 Bruitan
b veer: 0a A #
& Term g “aminim
& nr a4
JF | S— -
"1 uaa
|:h ¥
Comg Drep Charia E
Click heve w select walls B ot Treatir Ot |
1 ', i
Sanaghe WFL Cranpaes
LER
la
a4
a2z 4
|:| .
Click here n select walls
Analyte list Dashboard charts area Commands and
pane Display Options

Figure 5.1 Dashboard

MasterPlex® EX www.miraibio.com
67




CHAPTERS
NORMALIZATION & FOLD CHANGE

5.2

Checking the Data Distributions Using Multi Charts

There are three blank charts in the charts area by default and you can use these
charts for checking your data. Dashboard has four type of charts (Figure 5.1).

| Drag Drop Charts

Control Treatment Chart

== well Chart
|:-a: Analyte Comparison

|:-a: Sample MFI Comparison

Figure 5.2 Four chart types

Table 5.1 Charts

Chart Name

Description

Control Treatment
Chart

Display all treatments distributions which belong one
control group (Figure 5.1).

Well Chart

Plot MFI and normalized MFI simultaneously (Figure
5.1).

Analyte Comparison

Plot all data points between two analytes (Figure 5.1).

Sample MFI
Comparison

Correlation plot between sample amount and MFI
(Figure 5.1)..
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Control Treatment Chart

Control Treatment Chart plots all treatments data belong one control group
with an error bar (Figure 5.3). All control groups and treatments are plotted on
the chart at the same time. Chart can be copied or exported from context menu,
and display data type can be chosen from context menu as well (Figure 5.4).

Control Treatment
1400

@ ACTE
1200
1000
800
600
400

2004 * L .
pesl e o

T
Cirl 1 Cirl 2 Cirl 3 Cirl 4 Cil 5 Cirl &

Figure 5.3 Control Treatment Chart

Control Treatment
1400
| ) ACTH
1200 1 17
1000
.
] Export
600 -
| of | Display MFI
400 7] e Display Mormalized MFI
200 | ¥ o
(O SO o 0% -0l ]
Cil1Cil 2 Cirl 3CH 4 Cid 5Cirl &

Figure 5.4 Context menu for Control Treatment Chart
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Well Chart
Well chart plots MFI and normalized MFI data selected by the mini plate
selection tool (Figure 5.5). Chart can be copied or exported from context menu,

and MFI and normalized MFI data can be tuned off from context menu as well
(Figure 5.6).

Normalized by Geometric Mean
— CEL2 M
— 002 N-MFI
=
o
5
= L ) Faa 17w M
ﬁ I||: IIIII :-h'-;
(B! 8 | Fr g Cnaarae]
‘Ig'l 0 b | | "’“E W Al Aral
| . F )III ".l" || 1 fae =
| ) { II :IJ.E S il
| |I|' 'l.y|' b Laz
1 b LIS VS S— voperenprmeper- Fam
| / N -
Gl%H‘ﬂ“‘-l‘hﬁilﬂ-'.‘l;ﬂﬂlﬂl::lﬂilﬂﬂH;“P‘-;H‘-.ﬂ r“ - - . - - |]
R PP YR RPREREREYERRE R S -
| 2 5§ 3 5 5 3 35 393 353353531 1 « TR aCTare
T T R R T " E L T L . R R R OW T E—— PN
IEE%%E%E%EEE%E’E%%';’}_ﬂ""'» ﬂﬂl%‘::_;:—
|22 3B2FS8C8B232R3E ; o
I A T . =k e DeRAE I : :b’ s :.I ¥ :a Ei
L _ _ _ Samples (Well Position) | 2 =;I == E;]Z e

Figure 5.5 Well Chart

Normalized by Geometric Mean

12 ] 16 — IFNG MFI
1 ﬁ 1.4 — IENG M-MFL
10 \ L =
1 | Copy 9
8 ' é
i ] Expart =
= 6 N
1 W | Display MFI o
4 =
1 v | Display Normalized MFI m
a ]
] W Line Graph
0 1 T T
Popoow Area Graph
it 8 F T TTTOTY
EEk s R T 8 B 8 8
%8 : D E B

Samples (Well hﬁosition)
Figure 5.6 Context menu for Well Chart
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Analyte Comparison Chart

Analyte comparison chart plots all MFI or normalized MFI data between two
analytes with correlation line (Figure 5.7). Chart can be copied or exported
from context menu, and display data type can be chosen from context menu as
well (Figure 5.4).

Analyte Comparison
Y o={024m + 102.04
Correlation; (. 4%80
1400 -
1200 - -
1000 -
o 800
'_
g
600 -
400
200
U ‘I‘wr’ - T 2 T = T T T T T
0 300 600 900 1200 1500 1800 2100
GAFD

Figure 5.7 Analyte Comparison Chart

Analyte Comparison

Y ={024 ) + 102.04
Correlation; [ 458D

1400 —
1200 o )
1000 R o
Export
m 800 -
5 Display MFI
< 6004 @
3 Display Normalized MFI
a0 :
2001 ® —
0 p— — T T T
Q 500 1000 1500 2000
GAPD

Figure 5.8 Context menu for Analyte Comparison Chart
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Sample MFI Comparison Chart

Sample MFI comparison chart plots MFI and normalized MFI data selected by
the mini plate selection tool (Figure 5.9). Chart can be copied or exported from
context menu, and MFI and normalized MFI data can be tuned off from
context menu as well (Figure 5.10).

MFI / Sample Chart

N =004 + 0,67
Correlation; 0.9954

B0

70

60

MFI
g
1

T T T T T T
0 300 600 900 1200 1500 1800 2100
Sample Amount

Figure 5.9 Sample MFI Comparison Chart

MFI / Sample Chart

¥ =(033x+2.57
Correlation: 1.9980

700 -
600 . /
500 % Copy
5 400 - Export
= 300 - | & Display MFI
200 _— Display Mormalized MFI
100 ~ /
’ I - J I T T
0 500 1000 1500 2000

Sample Amount

Figure 5.10 Context menu for Sample MFI Comparison Chart
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Replacing the chart by drag & drop
Charts in the chart area can be easily replaced by drag & drop operation.

1. Select one of the chart you want to use from the drag drop charts pane
(Figure 5.11).

| Drag Drop Charts * |

Control Treatment Chart

== well Chart
|:-;: Analyte Comparison
|:-;: Sample MFI Comparison

Figure 5.11 Replace the chart by drag & drop

2. Drag & drop selected chart into the chart area you want to replace (Figure
5.12).
= The chart is replaced.

=t g

w B ArghTEE

=

Ly | a8

. | Coisg Do Chasty
Zlick here o select wilis
Cordred Tran e Churd
- "Vl Chart
|

Sarma V'L Compaemr

Figure 5.12 Replace the chart by drag & drop
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5.3

Normalization and Fold Change

Selecting a Normalization Method

1. Select an analyte from the left analyte pane.

2. In the normalization option pane, select one normalization method from the
drop-down list (Figure 5.13).
= Some methods needs to specify the normalization baseline item.

s

I Mormalization Options x |

Geometric Mean ia

Figure 5.13 Model Equations drop-down list

Table 5.2 Normalization methods

Method Description

None Nothing normalization is done.

Geometric Mean Use geometric mean method as a normalization baseline.

HK Gene Choose one particular housekeeping gene as a
normalization baseline.

HK With Least Automatically select a housekeeping gene which has least

<CV% CV% value as a normalization baseline.

Constant Use user inputted value as a normalization baseline.

Inter-Sample Use inter sample factor method as a normalization

Factor baseline.

Calculate normalization and fold change
1. Click Calculate button in the commands pane (Figure 5.14).
= If you want to calculate for all analytes at the same time, check ‘All
Analytes’ check box.
| Commands |

| All Analytes

L .
[ Calculzte

Figure 5.14 Model Equations drop-down list
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2. Fold changes are calculated after normalization calculation. (Figure 5.15).

& oL Control Treatment MFI / Sample Chart
CXCLe 1400 80,00 Y =(N3x+257
& oc T WA0IR Correlation; 0.9980
& GAFD o 116800
& 1cami 1200 1 T 5
il 1000 - 600
&s
& varks 200 ] 500
& TGFE1 T 400
] =
& TF 600 300
— 248 500020 Status ‘
200 GO0 A& N L
F fTr oo-sonf A J All calculations completed! | T T T T
o L AT p 500 1000 1500 2000
Cirl1C 2 Gl 3C 4 Cy Sample Amount
700 4| — ACTE MFI
600 - i IJ'I % o [TACTS oML
| | L o
500 || \ |||\ %83
g I| 'i i Hos 2
] | |
. = il {1 Lo4 &
200 4 i [ £
1 L JI N - 02 =
100 N L Famw, X §
U T I(-'I_ L R R § il LAY Lt R Bl § I----I Ll Bl Bl R R | I._FI ™ I\I {3 eh Ml Sl Wt M i i b 0
P Bl R B R E B B o ]
53333 33 3333333333333 3z5g3z33 3333 I3 FIaT
IE2 SR ERE RS R A R A R R AR R R R AR RN
SEEEE O3 PPN B E2E TN RAERRRTNODE RS
EREEDDEZEECERCTEERRE0R2Z2ppeREEERESR
Samples {Well Position)

Figure 5.15 Fold Change Calculation
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6 | Reviewing Data — Data tab
Data tab is to review the data across all analytes. In this tab, you can:
Add or delete the data column via column selector box
Sort or filter the column data
Change the column layout
Make groups to categorize the data
Print or export the data

Data tab

Plbsbir. | (aibbuece QSO Chass | Eapest |

Sraw Coborm Selmrks Eigorit=ife i Wit P HJ_ Tebw Tarminis

ol

ol s Harns Graup R L ot} A - Bactrours Hamstred M R4 o nge Foin Charga Pz Thanga & . [ TiRTL =
¥ =iF L
Bl Terow AL 1313 LIEEC DD LoD a3 e ] nm =
Bl Eprpie 81 15300 12000 (1401 PR (1401 110 ]
CL T I SFLH R ) (4 e 1.3 (4 e 24«1}
Eri Sawnpde . 34,50 A 50 1150 L] 1150 [0
El TsrpuEl 24 g4 Ll o] Lol ] Ll o] oo
FL gl F1 i BELDD £y 1.0 £y ]
Gl e Gl 1304 (LA (=2 14K (=2 D.oo
HL Eenplt H| 15/ L0 (AL A By n
EZ Camoie A2 1.33 I0D [ ] 0,3 [ ] LoD
B2 Campi A1 ] <00 L)) L] L)) 0
O3 Sairnpwm (T 13 F e [N o] L] [N o] o
D Bewnipde: O 1M 200 (L] 2.4 (L] D
o Serpe Bl RS IO 18 e ] L] 18 e ] [ e]
71 EmnpieFl =40 EE4100 £ 1.3 £ 0
o2 Seooi I 3450 18450 IO .30 IO LLOD
. Sl HE 112,50 24250 £y P ELY £y b0
B3 Zaeow A3 113 Lo LoD a3 (e nm
B3 Epapi 83 ¥/M .00 (1101 PR i (1401 1]
ma iy e T3] 7. [ (4 e 1.3 (4 e 24« 1]
PN Endrada. 1t Pinn v LI L LT

Figure 6.1 Data Tab |
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6.1

Add or Delete a column

1. Click Show Columns Selector @  ShowCalumnsSelector bytton.

= Column selector appears(Figure 6.2).

Customization x
Count

Fold Change Stdew

MFI %V

MFI Average

MFI Stdev

M-MFI Stdev

Outlier

Figure 6.2 Column Selector box

2. To add a data column, select one of the data types and drag & drop it onto
the data grid (Figure 6.3)

me MFI MFI - Bacgground Mormalized MFI M-MFT A
MFLAvemqe %
1158.00 1168.00 0.00
1230.00 1280, 00 0,00
232,50 Customization x
254,50 Count
64,00 Fold Change Stdev
53.00 \MFI SeCWY
15.00 MFI Average
15.00 MFI Stdev
3.00 MIFT Stdew
4,00 ,
Cutlier
2.00
2.00
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Figure 6.3 Add data type to the data grid
3. To delete the column from the data grid, select desired column and drag &
drop it away from the column (Figure 6.4).

ne MFI

MFI - Background T| Mormalized MFT | N

I

1163.00
1230.00

239,50 MIFI-Ba

284.50
&4.00

1163.00 0,00

1280.00 0.00
TrEREF 0,00
284.50 0.00

&4.00 0,00

Figure 6.4 Delete data type from the data grid

Table 6.1 Data Types in the Data Table

Data Type Description
Well Well name
Bead Name Bead name

Sample Name

User-specified name for the well.

Group Name

The group number of the well. Wells that belong to the
same group have the same group number.

Outlier Outlier status

MFI (Median The med(i@an fluorescence intensity measured by the
Fluorescence Luminex~ 100/200 or BioPlex system for a bead set count.
Intensity)

Normalized MFI Shows calculated Normalized MFI value

Fold Change Shows calculated Fold Change value

MFI - Background | Background subtracted value from MFI.

MFI Average Shows the MFI| average within the group.

MFI Stdev Shows the MFI standard deviation within the group.
MFI %CV Shows the MFI %CV within the group.

Count The number of beads (per bead set) detected by the

Luminex® 100/200 or BioPlex system.

N-MFI Average

Shows the Normalized MFI average within the group.

N-MFI Stdev Shows the Normalized MFI standard deviation within the
group.
Fold Change Shows the Fold Change average within the group.
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Average
Fold Change Stdev | Shows the Fold Change standard deviation within the
group.
Group Link Control group associated with this well
6.2

Sort or Filter the Column Data

To sort by specific column, click the column title. Ascending and descending
are changed alternatively (Figure 6.5).

I e —
0 'y 0 0 i
e MFI N MFI ne y ¥ MFI

\ Descending sort —
36.00 10476.00

Ascending sort

35.00 29994, 50
37.00 6239.00
37.00 6112.00
37.00 5551.00
33.00 5533.00
33.00 4971.00
33.00 4871.00

Figure 6.5 Sort Column Data

To clear the sort, right click on the column you want to clear the sort, select
‘Clear Sorting’ from the menu (Figure 6.6).

2l Sort Ascending
2| sortDescending

Clear Sorting

= Group By This Column

B memiim Dy Dimss

Figure 6.6 Clear Sorting
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To filter by specific data in the column, click upper right side of the column
you want to use it as filter base (Figure 6.7).

well T Sample Name
*la Bead Mame: GM-CSF
Al
Bl
C1

= |

el

{hustom)
a (Blanks)
= B2t (Non blanks)

ail
AZ
Taz
0 A4
A5
AF
Fa7
48
Ag
HB1
JE10
B2
B3
dE4
4B
]

AEN

Wwell Sample Mame

= Bead Mame: GM-CSF

A10

& Bead Mame: IFM gamma
A10

= Bead Mame: II-1Beta
A0

Figure 6.7 Filter by the data in the column

NOTE: There is a way to construct more complex filter conditions using Filter
Builder. See appendix A section A.1 ‘Create Complex Filter Criteria’ paragraph.
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6.3
Exporting a Data

You can export your data table data from Export to File button .. .
1. Click Export to File drop-down button.
2. Select the file format you want to export
= There are five file formats available: Excel, CSV, PDF, HTML and Text
(Figure 6.8).

Export to File

Figure 6.8 Export to File menu

3. File save dialog appears. Set file path and input file name, then click OK
(Figure 6.9).

q Fia camw | a | i i I Ean |

Ry Motaridc Semarpos Euoel st w e
i B 17y

Figure 6.9 File save dialog
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4. After saving the file, an Open file prompt appears (Figure 6.10). If you want
to open the saved file immediately using the program the files extension is

associated with, click Yes.

= The saved file is opened on the program. (Figure 6.11).

Open file

\‘.‘:) Do you want to open it now?

e

No

[dyoe tot pow (ot Fgmal Dre Do e b ¢ 3 [ P B
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Figure 6.11 Opening in Excel
® .
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6.4

Printing a Data

You can preview your data with the Print Preview button =
1. Click the Print Preview button.
= Print preview window appears (Figure 6.12).

L8 Preview - B x
File View Background
P E O e L B R & R [0 -fag| bl | B B -
well |  sampleName |  GroupMName | MFI | mFiAverage | count | B
Bead Name: GM-CSF
Al Background 1 41.00 0.00 189
Bl Standard 1 10516.00 2970.39 208
C1 Standard 1 6152.00 2970.39 225
D1 Standard 1 3104.00 2970.39 213
El Standard 1 1040.00 2970.39 181
Fi Standard 1 292.00 2970.39 165
G1 Standard 1 108.50 2970.39 190
H1 Standard 1 56.00 2970.39 183
AZ Background 1 39.00 0.00 194
B2 Standard 1 10034.50 2970.39 152
R ]
Current Page: 1 | Total Pages: 17 | Zoom Factor: 130% |

Figure 6.12 Print Preview

2. To print, click the Print &' icon from the menu bar.
= Print setting dialog appears.

|j. NOTE: For more printing options, see appendix A section A.2 ‘Print Preview’ menu.

MasterPlex® EX  www.miraibio.com
83




CHAPTER?7Y
DATA CHARTS

CHAPTER
7

Data Charts — Charts tab

MasterPlex® EX can display MFI, count, or concentration data in many graph

formats in the charts tab.
Charts tab

e - =

TR T TIPS |

Salected analytes in well Sample ALAL)

1600 | W
i HWoos
| Eeak)
£ ] [
B i
M Fi
| I3
B reFiE
I TEFEI
B wF

I T

L e e ty] [F¥: [I1] PLFEE TR ThiF

- meodo Cratisfl b

Figure 7.1 Chart tab

71
Viewing a Data Chart

1. Click the Well Selector button.
= A mini sized well plate is displayed under the button (Figure 7.2).
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Figure 7.2 Well Selector

2. Select the wells you want to display on the chart. You can select multiple
wells by pressing [CTRL] key (Figure 7.3).

B} AP ag-

AL S S S LR

Mo TTigarerea B1 Bmim -1 p = n4 s & na TRF spha
Sokttad Anakies

Figure 7.4 Multiple Well Selection
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3. To display another data type for the selected wells, click the Data Type
drop-down list and select one of the data type.

Table 7.1 Data Types

Data Type Displays...

MFI MFI (Median Fluorescence Intensity).
Count Bead count

Normalized MFI Calculated Normalized MFI

Fold Change Calculated Fold Change

4. To change the data type, click the Chart Type drop-down list and select one
of two chart types.

Table 7.2 Chart Types

Chart Type Displays...

Well Group Analyte data for each user selected well.
Single Analyte Single analyte across all user selected wells.
Group by Analyte Wells grouped by same analyte name.
Group by Sample name | Wells grouped by same sample name.

Replicate View

Plotting group values is available by clicking the Replicate View button ﬁ] :
Replicate View is available only on Bar style charts. If you are on another
type of chart when you click the Replicate View button, it automatically
re-selects the Bar chart and displays the data with error bars. Figure 7.5 shows
an example of the replicate view chart.
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Selected analytes in group Standard 1
Average
[ am-csF
+Stdev \ [T 1FM gamma
[ 1-1 Beta
Average E e
-Stdev = Mo
s
s
s
Average |1 THF alpha
value (&

12201.75 12293.75

GM-CSF IFM gammaIl-1 Beta  IL-10 IL-z IL-4 IL-5 IL-& IL-3

Selected Analytes

63,25

THF alpha

Figure 7.5 Replicate View chart
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7.2

Chart Format

MasterPlex® EX provides various chart formats (Table 7.3). To change a chart
format for the selected well data, click the Chart Gallery button JJ , and
make a selection from the drop-down list of Chart Gallery.

Table 7.3 Available chart format

Icon | Chart Name Features

Bar Bar style x-y chart

«] |Bar3D 3D bar style x-y chart

'3 | Manhattan Bar | 3D bar style x-y-z chart

. | Point Point style x-y chart

2. | Line Line interpolated style x-y chart

|'.: | Step Line Step line interpolated style x-y chart

., | Spline Spline interpolated style x-y chart

4, |Line3D 3D line interpolated style x-y chart

- Step Line 3D 3D step line interpolated style x-y chart

f | Spline 3D 3D spline interpolated style x-y chart

o | Area Are painted style x-y chart

| . | Spline Area Spline area painted style x-y chart

Ly |Area3D 3D area painted style x-y chart

Ly | Spline Area 3D 3D spline area style x-y chart

. | Pie Pie style circular chart

-~ |Pie3D 3D pie style circular chart

L Doughnut Doughnut style circular chart

w> | Doughnut 3D 3D doughnut style circular chart
Radar Line Line interpolated style radar chart
Radar Point Point plotted style radar chart
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7.3

Analyte Selector

In the Well Group chart, Analyte Selector allows you to change the analytes
position in the chart and allows you to display on/off setting for each analyte.
To move the analyte position,

)
1. Click Analyte Selector icon @ :

= Analyte selector drop-down list appears (Figure 7.6).
2. Select the analyte you want to move.
3. To move the analyte to the left, click Up button. To move the analyte to
right, click Down button.
= The analyte moves one position to the left (or right) from its current
position (Figure 7.7).

In the Single Analyte chart, the Analyte Selector allows you to select the
analyte you want to display in the chart (Figure 7.8).

B
. | IFM gamma
All Analytes in the B -1 Beta

plate. To turn the ] 1L-10
display of the L2
| i W IL-4
analyte on or off, 715
check the box next ¥ L6
. | IL-8

to it. | |®] TNF alpha

Up

Down

Figure 7.6 Analyte Selector drop-down list
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12000 +

10000

&000

M-CSF IFM gamma II-1 Beta

I

12000

10000

G000

MFI

6000

4000

2000

IFMN gamma I-1 Beta

Figure 7.7 Change the analyte position

All Analytes in the
plate. To select the
analyte, click the
radio button next to
the analyte name.

12 GM-CSF
) IFM gamma
) II-1Beta
CIL-10
OIL-2
OIL-4
F1L-5
s
©I-s

) TNF alpha

Up

Down

Figure 7.8 Analyte Selector drop-down list
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IFN gamma

IFN gamma
[ 1-1 Beta Select the analyte | ¥/1-15ets
%it':} and click the %it;ﬂ

- ‘D " button. B

&1 own’ button H14
[ 1L-5 |:'> W] 1L-5
%IL-G %IL-E

-2 IL-3
[&] THF alpha [&] TMF alpha
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7.4
Changing the Color Palette

There are 30 color palettes available from Color Palette button n Figure
7.9 shows the palette names and their corresponding color patterns.

Apex (== [ ] Mature Colors T I I Y O
Aspect EEEEEN Morthern Lights INENEREEEECOE
Black and White HENEEC Office L [ 5] [ ]
Chamelean EEEERERERNECOED Opulent | [ | [ []
Civic [ [m[E] (5] Oriel EENCE.
Concourse L[ [ [ []] Origin HECCT N
Equity L | ][] ] Paper ] [ ]
Flow EEEEEE Pastel Kit [ | [m[=[m(] S
Foundry BECEES Solstice [ (m [
Grayscale | [ ] ] Technic ]
In A Fog {5 T T [ Y B O Terracotta Pie [ [ [
Median ENNENN The Trees [ L O] (o0 [ [l [l
Metro i (m [ ] ] Trek =] (S]]
Mixed ANEEEEEEEEEN Urban [ | [ [ [ []
Module [ ] Verve L[ [ [ ]]

Figure 7.9 Color Palettes
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7.5
Changing Chart Properties

The Chart tab has great flexibility in customizing the chart. To enter the chart
properties dialog, click Chart Properties button Q . You can choose to
change the entire chart’s properties or just one of them. To change the entire
chart’s properties, click body of the@ button. To change one of the chart’s
properties, click small drop-down arrow right side of the button (Figure 7.10) .
Figure 7.11 shows Chart Properties dialog, and Table 7.4 explains the property
categories.

Click small down arrow

Q v/ mark to show the each
= [

chart’s property selection.

L]
Chart for well 41
Chart for well B1

Chart for well C1

Figure 7.10 Chart Property for Individual Chart

| Frswrm aftegeis |
= . .ﬂ' Cimtamics e lepared & prapaste,
A o Galected analytes & well C2 o ik
| R - 1000 < = = B T siphs Cepcin TooTisTie
Ab i gk e | |l c—
I | § 11 Beta Y
i< - e M 1o vartza: Tan - B
— - Hrmems  Agrmaces +
[ .o ]
e o | . s C—
1 (=1 T £
E? 2 pegar e I L I B e | ‘:: \erbos: I .
] ..o P00 ] P e - HpiEnt il
[rs | *
| * sl ] T
lEoas o oo 2
w00 4 Nmrtes ("L} {11 £l
| HOFERnE | W 1 S o
] | L
|
Fa L) i
|
toce 4
o L . o
TRF ey (O peoliigis 10 112 [R5 Be% [l
Seltecied Amalytes
| | = i 4

Figure 7.11 Multiple Well Selection
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Table 7.4 Chart Properties

Properties |Ilcon | Features

Legends B3] Customize the legend’s properties.

Diagram #) | Customize the diagram’s properties.

Axes M Customize X and Y axes of the diagram. Note that
you may select an axis to be modified on the chart
preview.

Chart Titles AD | Add chart titles to be displayed within a chart.

Point Labels Customize point label properties of the selected

series. Note that you may select a series to be
modified on the chart preview.

Series Views

Customize series view properties of the selected
series. Note that you may select a series to be
modified no the chart preview.

Appearance

Choose a palette to color series or their data points.
Also choose the style, which specifies the chart’s
appearance depending on the current palette.
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7.6
Chart Template

You can save the chart properties as a template. You can apply a template to
an active chart. Templates may also be exported, imported, or deleted.

Opening the Chart Template Manager
1. Click the Chart Template Manager button aj
= The Chart Template Manager appears (Figure 7.12).
2. Click a chart template in the Available Templates list to view information
about the template.

Template Manager x

& My favorite Mame: y-znalyte x-MFT black.mxtc

Created by:
Creation date: | 2/24/2009

Creation time: | 10:53: 16 AM

Description: il

| Load | | Save |

| Export | | Impart |

| Overwrite | | Delete |

| Close |

Figure 7.12 Chart Template Manager shows available templates
Click a template to view information about the template.

Saving a Chart Template

You can save the current chart properties to a template.

1. After you have finished modifying the properties, open the Chart Template
Manager and click the Save button.

= The Template Name box appears (Figure 7.13).
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Template Information x

Mame: |

Description:

| K || Cancel |

Figure 7.13 Template Name and Description box

2. Enter a name for the template and click OK.
= The new template is added to the Available Template list.

Loading a Template

You can apply or load a saved template to the current chart.

1. In the Template Manager, select the template that you want to apply to the
chart.

2. Click the Load button.
= The template is applied and the properties are set to the current chart.

Overwriting a Template
You can overwrite an existing template with the current chart properties.
1. In the Chart Template Manager, select the template that you want to
overwrite
2. Click the Overwrite button.

= A confirmation box appears (Figure 7.14).

WWarning X
v E Are you sure you want to overwrite 'y-analyte x-MFI black'?
*

| ............ OK ............. | gancel -|

Figure 7.14 Confirmation box
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1. Click OK to overwrite the selected template with the current chart
properties.

Exporting a Chart Template
You can export a template to a user-specified location.
1. In the Chart Template Manager, click the template you want to export.
2. Click the Export button.
= The Save As dialog box appears (Figure 7.15).

v @ % &

Savein: | | examples

Ity Recent
Documents

My Documents

-3

My Computer
e i i
‘r.,-l File name: | | Save
B , =
My Metwork Save as type: | MasterFlex Chart Template {7 mdc) vl Canicel

Figure 7.15 Save As dialog box

3. Choose the directory for the template that you want to export.
4. Enter a name for the template (*.mxtc).

—q?- NOTE: A template must have a .mxtc file extension. Changing the extension will
render the exported template unusable.

Importing a Chart Template
You can import a chart template (.mxtc) from a user-specified location.

MasterPlex® EX www.miraibio.com
96




CHAPTER7?7
DATA CHARTS

1. In the Chart Template Manager, click Import button.
= The Open dialog box appears (Figure 7.16).

Lok in: |rjaxamples ‘VI 0 T e '
EY et
e
Ity Recent
Documents
FT-
Desktop

My Documents

58

My Computer
i._;l File name: | bt | [ Open l
e
Wy Netwiork Files of type: [M_a_s{ler_P_Iax Chart Ten_'uE_I.?t_e {" moc) w ! [ Canicel l

Figure 7.16 Open dialog box

2. Choose the directory with the template that you want to import.
3. Select the template and click Open.
= The template name is added to the Chart Template Manager.

Deleting a Template
You can delete a template (.mxtc) from the system.
1. In the Chart Template Manager, click the template that you want to delete.
2. Click Delete button.
= A confirmation box appears (Figure 7.17).
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WWarning x

L] E Are you sure you want to delete 'v-analyte x-MFI black'?
*

| Cancel |

Figure 7.17 Confirmation box

3. Click OK to delete the template.
= The template is removed from the Chart Template Manager.

/|\ WARNING: This permanently removes the template from the system.
L]

WARNING
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1.7

Printing a Chart

You can print your data with the Print button

1. Click the Print Preview button.
= Print preview window appears (Figure 7.18).

(8 Preview

File ‘View Background

| el G Ly B P R | B e0%

- i)

| Corrent Page: 1

BHMZP IMigenme -] Cets L1 Iz L4

Selected analybes in well Al

Selected Arialytes

| Total Pages: 6

i}
= o-g

[
L=

| Zoom Factor: 60%

Figure 7.18 Save As dialog box

2. To print, click the Print &’ icon from the menu bar.
= Print setting dialog appears.

ﬁ. NOTE: For more print options, see appendix A section A.2 ‘Print Preview’ menu.
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7.8
Copying or Saving Chart Image

The software can export the chart image to other applications. The data may
be copied to the system clipboard or saved in different file formats.
1. Right click on the chart you want to copy or save.
2. To copy the chart image in bitmap format, click ‘Copy’.

= The image is sent to the clipboard and you can paste the image data on

other applications.

3. To save the chart image in other formats, click ‘Export Image’.

= The File Save dialog is opened (Figure 7.19).
4. Input the file name and select one of the file formats from the ‘Save as type’
drop-down list. There are five formats available: bitmap, png, html, pdf and
Excel.

Save in: @ Desktop v O T £® M-
El
i)
My Recent
Documents
o
Diesktop
My Documents
58
My Computer
£ >
"r:!l File name: m ~ |
Wy MNetwork Save 3z type: | PNG " !

Figure 7.19 Chart Image Export dialog
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CHAPTER

8 | Export Data — Export tab

This chapter explains how to export MasterPlex® EX data transformed by the
user. Custom report is a powerful and flexible tool for presenting and
exporting your data. Compared to regular report, Custom report has greater
flexibility on what and how to present data. While EX stores its analysis
results in an XML format document, it is possible for users to present their
data in whatever format they want. The only thing users need to do is to define
their presenting formats in XSL files (Extensive Stylesheet Language).

Figure 8.1 Export Manager tab

| “Sivie Termmiw

[y 313 plade ey HTRE

BB Cusion et T
B Cusione cein Rranid

B St Epp Teresil

| 3ty Irforrmts
wrm: 3u1d b rean ATRL
Fodrtud Tone: 512513008 S0 57 P

Tuiput MelSoc Hn
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8.1

Importing a User Defined Stylesheet

1. Click Import button | meort
= The file open dialog appears (Figure 8.2).

Open X

Look in; |i:;'}examples V| & ¥ £ DI
Ty | all_csv.xsl
! Ea H morm _xml, xsl
My Recent & all_xrml.xsl
Documerts | first_analyte_htmil.xsl
= 4| conc_unk_xml.xs|
|_ ; i all_html.xs|
Desidon Chdata
My Documents
Iy Computer
@ e 9
My Network | Flesoftyps: | MasterFlex Tempiate (") v

Figure 8.2 Open File Dialog

2. Select the file you want to import to the export manager.
= Style sheet’s name is displayed in the Style Sheet list, and XSL
Information window shows style sheet’s information (Figure 8.3).
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e

| Report Template
Fz; 512 plate map HTML

FH Custom data format2
R Custom data format1
FF Tab Format
£ PlateFormat

Feport Information

e

Mame: Sx12 plate map HTML
Modified Time: 1/11/2010 6;30:00 PM

Cukput Method: Heml

Figure 8.3 Open File Dialog

8.2

Exporting a User Defined Stylesheet

1. Click Export button | - ‘ :
= The file save dialog appears (Figure 8.4).
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Save As E| g|

Save in: |u;‘}examples v| Q ? e il

L&b # norm_xml, xs|
My Recent i all_xrol, xsl
Documents | first_analyte_himl, xsl

= g conc_unk_xml.xsl

| A all_html. sl

Cieskiop (Ddata

My Documents

Iy Computer
@ ~— | g
My Network | Saveastype: | MasterFlex Style Shest (") v

Figure 8.4 Open File Dialog

2. Set the destination and input file name, then click the Save button.
= Style sheet’s name is displayed in the Style Sheet window, and XSL
Information window shows style sheet’s information (Figure 8.3).

8.3
Delete Style Sheet File from Style Sheet List

1. Select the style sheet you want to delete from the style sheet list.
2. Click the Delete button |E\ :

= The confirmation dial@ears (Figure 8.5).
3. Click OK to delete.
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WWarning x

L] E Are you sure you want to delete "All_HTML'?
P}

| Cancel |

Figure 8.5 Confirmation Dialog

8.4
Viewing Original Data

1. Click View Original button | =W ongnd ‘ .

= Original data by xml format is displayed in the preview window (Figure

8.6).

<?xml version="1.0" encoding="utf-8" 7=
- «MasterPlexPlateData>
<Row=>8</Row>
<Col=12=</Col=
<FileName />
<PlateMame /=
“PlateType=1</PlateTypes
<RunDate /=
<RunTime /=
<anlyDate /=
<AnlyTime />
<Operator />
<L XVERSION />
LXHWSHN /=
<Beadlnfo beadname="GM-CSF" id="0" bkgvalus="0" stdunit="pg/mL" /=
=BeadInfo beadname="IFN gamma" id="1" bkgvalue="0" stdunit="pg/mL" /=
<BeadInfo beadname="II-1 Beta" id="2" bkgvalue="0" stdunit="pg/mL" /=
<BeadInfo beadname="IL-10" id="3" bkgvalue="0" stdunit="pg/mL" /=
=BeadInfo beadname="IL-2" id="4" bkgvalue="0" stdunit="pg/mL" /=
<BeadInfo beadname="IL-4" id="5" bkgvalue="0" stdunit="pg/mL" /=
<BeadInfo beadname="IL-5" id="6" bkgvalue="0" stdunit="pg/mL" /=
<Beadlnfo beadname="IL-&" id="7" bkgvalue="0" stdunit="pg/mL" />
<BeadInfo beadname="IL-8" id="8" bkgvalue="0" stdunit="pg/mL" /=
=BeadInfo beadname="TNF alpha" id="9" bkgvalue="0" stdunit="pg/mL" /=
- =Well wellid="1" type="0" name="" addr="A1" group="-1" replicateid="" dilution="1"
ignorewell="" wellcolor="" rowid="1" colid="1" refctriwell=""=
<Bead id="0" mfi="92" conc="0" count="204" status="1" constr="" resstddev="0"
sampleavg="0" samplecv="0" constddev="0" conavg="0" concv="0" normfi=""
resulthdr="" /=
<Bead id="1" mfi="2836" conc="0" count="149" status="1" constr=""
resstddev="0" sampleavg="0" samplecv="0" constddev="0" conavg="0"
concv="0" normfi="" resulthdr="" />
<Bead id="2" mfi="103" conc="0" count="124" status="1" constr="" resstddev="0"

Figure 8.6 Confirmation Dialog
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2. To save this data, click the Save button .
3. To print this data, click the Print button .

8.5

Transform Original Data into Your Customized Data

1. Select the style sheet you want to apply from the style sheet list.

2

4

. Click the Apply button |

Apply ‘ .

= The transformed data is shown in the preview window (Figure 8.7).

Flat File by Determination

FileName

C:Documents and
Settings'tshimizu' Desktop' examples' H10Plex csv

C:Documents and
Settings'tshimizu Desktop' examples H10Plex csv

C:Documents and
Settings'tshimizu' Desktop' examples' H10Plex csv

C:Documents and
Settings'tshimizu Desktop' examples H10Plex csv

C:Documents and
Settings'tshimizu' Desktop' examples H10Plex csv

C:Documents and
Settings'tshimizu Desktop' examples H10Plex csv

C:Documents and
Settings'tshimizu' Desktop' examples H10Plex csv

C:Documents and
Settings'tshimizu Desktop' examples H10Plex csv

C:Documents and
Settings'tshimizu' Desktop' examples H10Plex csv

C:Documents and
Settings'tshimizu Desktop' examples H10Plex csv

C:Documents and

I3

RunDate RunTime SampleWell AnalvteName WellTvpe SampleName N

[9/12/2008 |8:10 PM
[9/12/2008 |8:10 PM
[9/12/2008 |8:10 PM
(9/12/2008 |8:10 PM
[9/12/2008 |8:10 PM
97122008 |8:10 PM
[9/12/2008 |8:10 PM
[9/12/2008 |8:10 PM
[9/12/2008 |8:10 PM

[9/12/2008 |8:10 PM

QM1 2/7NNE IR-1N DA

Al

Al

Al

Al

Al

Al

Al

Al

Al

Al

R1

GM-CSF

IFN gamma

Il-1 Beta

1L-10

IL-2

1L-4

IL-5

IL-6

IL-8

TNF alpha

CAILCSE
|

I;igure 8.7 Transformed Data (HTML format)

3. Save to file or print from the menu button.
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Other
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APPENDIX
A

This appendix explains more details about Data Grid (for Standard curve tab
and Data Table tab) and Print Preview.

AA1

Grid Customize Menu

Grid customize menu allows you to customize your grid data viewing more
flexibly and efficiently. Grid Customize Menu is invoked by right clicking on
the both grid column, standard curve data grid and data table grid (Figure A.1).

Beas Mere o

i ; r Vel _ Sampie Name Group Mar
e :
. I %l Sort Ascending El Sort Ascending
o Anend e 4
L El Sort Descending S Bead Nar El Sart Descending
El G Al !
il 21
= Group By This Column i 1 | B Group By This Column
| B Hide Group By Box £ r1 | B2 Hide Group By Box
' € £l
| Remove This Calurn | Remave This Column
= 5 E =
I Column Chooser Colurmn Chooser
c1
I—| Best Fit . Il Best Fit
Best Fit {all columns) | - Best Fit {all columns) |
% Filter Editor... g2 | Y Fiker Editor...
o ™ i i

Figure A.1 Grid Menu in the Standard Curve tab and Data Table tab

Table A.1 Main toolbar buttons and functions

Icon | Command Function
A ,I.. Sort Ascending Sort right clicked column by ascending.
£
ra l Sort Descending Sort right clicked column by descending.
lﬁl
Clear Sorting Clear sorting of right clicked column (if the
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columns is sorted).

Group By This Column | Make a group by right clicked column. The
group is located under the last position of

current group hierarchy.

Hide Group By Box Display/Hide Group Box (Figure A.2) on the
upper side of the columns. It enables you to

make group(s) by drag and drop operation.

Remove This Column Remove right clicked column.

? Column Chooser Show Column Chooser box.

t
Iﬁ Best Fit Adjust the width of right clicked column.
}af" Clear Filter Clear filter condition of right clicked column
(if column is filtered).

"‘F Filter Editor Open Filter Builder window (Figure A.6).

Best Fit (all columns) Adjust the width of all columns.
Group Box

The Group Box appears on the upper side of the column (Figure A.2) by
choosing the Group By Box menu from the right click menu on the grid
column. You can drag one of the column you want to group to this box (Figure
A.3). Also you can multi-group by repeating same way (Figure A.4).

1| | Show Coldmns Selector Export to File '—K Print Preview -
Well Sample Mame Group Mame MFI MFL Aw
% E Bead Name: GM-CSF
Al Background 1 41,00
B1 Standard 1 10516.00

Figure A.2 Group Box
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| well | 5a Mame | Group Name
_! A ]_ i FET—
| B1 : T
i c1 ] % WEry : Bead MName ]_[
= | = Al GM-CSF Bact
D1 | Bead Mame —
= . | B1 GM-CSF Star
> El | Conc, %CY = = PRt
i | Conc, Stdev
= |
| Gl Dilution @
Well Sample MName Group Mame
>
| B Bead Name: GM-CSF
Al Background 1
B1 Standard 1
C1 Standard 1
n1 Standard 1

Figure A.3 Group by Drag & Drop

Well | EEmpiE ; Well | Sample Name
! ? | & Bead Name: GM-CSF i & Bead Name: GM-CSF
|_ A1 Background 1 - B Group Name: Background 1
I Ri Standard 1 Al 4
N 3

B Group Mame: Standard 1
Bl 1051€

C1 615z

Figure A.4 Multi-Group by Drag & Drop
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Group Box Menu

Group Box has context menu. Table A.2 shows the menus.

Table A.2 Main toolbar buttons and functions

Icon Command

Function

— Full Expand

Expand all group trees.

Full Collapse

Collapse all group trees.

Iﬁ Clear Grouping

Clear group and return the group columns to

the grid column..

Working with Column Filter
There are two ways to set a filter. The first way is by using the filter
drop-down menu from the column (Figure A.5). You can filter the column by
selecting the specific data in the column. The second way is by using the
Filter Builder window (Figure A.6).

well ¥ Sample Mame |:>

*la Bead Mame: GM-CSF
Al
Bl
s |

=l Bead

I

a
O
E
F
H
.
E
C
O
E

ey Wi |:'> well Sample Mame

)
hustom) |

(Blanks) 3
= = 3 ' e
(Mon blanks) | [ = Bead Mame: GM-CSF

Al 410

AZ : -

= Bead Mame: IFM ga

]
T
i

il

A3
Ad A10
AL
Ad = Bead Mam
AT
Az
Ag
B1
B10
B2
B3
B4
BS

B& -~

m
m
m
il

A10

F2

Figure A.5 Direct Filtering from the column

MasterPlex® EX www.miraibio.com
110




APPENDIXA
PREFERENCES

Create Complex Filter Criteria

To construct filter criteria involving multiple columns and various comparison
operators, use the filter drop-down list and click Custom. This invokes the
Custom AutoFilter dialog (Figure A.6) which allows you to compare a column
with one or two values. To construct using more various operators and
multiple conditions, use the filter builder. See ‘Basic step for constructing
Filter Criteria by using Filter Builder’ paragraph in this section.

Custom AutoFilter X

Show rows where:

equals - IL-10
) And B Or
equals - IL-12
| QK | | Cancel |

Figure A.6 Custom AutoFilter dialog

Filter Builder Window

By using the filter builder, you can filter the data more specifically. To open
the filter builder window, choose Filter Editor from the right click menu on
the column or click Edit Filter button on the bottom of the data grid (Figure
A.7).

wWell Sample Mame Grou

21 Sort Ascending

= il Sort Descending

q = Group By This Column
0 |ES| Group By Box
§ 8 Column Chooser
R 5] BestFit
E F
L

Best Fit (all columns)

m te T

T ——

Figure A.7 Opening the Filter Builder
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Basic steps for constructing filter criteria with the Filter Builder
1. Right click on the grid column.
2. Choose Filter Editor.
= Filter Builder window appears (Figure A.8).
Click to change the

current operator, Ep Fiter Buider
add/remove conditions |:

and groups of / [sample Name]
. dample Mamej Degins with <enter a valle =
conditions. ) .
\‘ To remove filter condition,

@ And click [x] button.
@ Or

To add filter condition,
click [+] button.

@ Mot And
@ Mot Or

=, Add Condition oK Cancel Apply

=+ add Group

# Clear all

Figure A.8 Filter Builder Window

3. Click [Sample Name] and choose one of the column item.

4. Click Equals and choose one of the operator. Table A.3 shows the
conditions you can choose from.

5. Click <Enter a value> and enter the operand value.

6. Click the Apply button to apply the filter setting to the grid. If you want to
apply and close the Filter Builder window, click the OK button.

Table A.3 Available Commands for Filter

Icon | Operator Function

— | Equals Shows only [Sample Name] = <value>.

7 | Does not equal Shows only [Sample Name] # <value>

& Is greater than Shows only [Sample Name] > <value>.

= | Is greater than or equal | Shows [Sample Name] = <value> and
[Sample Name] > <value>

£ Is less than Shows only [Sample Name] < <value>

-t;._.l Is less than or equal Shows [Sample Name] = <value> and
[Sample Name] < <value>
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A% |ls between

Shows only the value which has between first

<value> and second <value>

4L | Is not between

Shows only the outside value which has between

first <value> and second <value>

abc | Contains

Shows only the value contains <value>

ach | Does not contain

Shows only the value does not contains <value>

[2]b | Begins with

Shows only the value starts with <value>

Blc] | Ends with

Shows only the value ends with <value>

a=c | Is like

Shows only [Sample Name] > <value>

a=c | Is not like

Shows only [Sample Name] > <value>

Shows only value are blank.

(_J |lIs blank
. Is not blank

Shows only value are not blank.

Shows only value which has <value>s.

*
oo | Is any of
203 | Is none of

Shows only value does not have <value>s.

ﬁ Firer Builder x Well Group Mame MFI
& = Bead Mame: GM-CSF
. F1 Standard 1 292,00
e ead MName] Equals GM-CSF
5 i L I:> F2 Standard 1 300.00
o [MFT] Is between 200,00 and 500,00
_______ . E6 Unknown 1 270,00
> [Bead Mame] Equals IL-10 G5 Unknown 1 SLiail
‘e [MFI] Is betwesn 500,00 and 1000,00
=l Bead Mame: IL-10
H1 Standard 1 587.00
| oK | | Cancel | | Apply HZ Standard 1 550.00
| | B3 Unknown 1 587.00
Shows only E4 Unknown 1 575.00
Bead name is ‘GM-CSF’ and MFI is between 200 and 500, B& Unknown 1 £21.50
or C7 Unknown 1 866,50
Bead name is ‘IL-10" and MFI is between 500 and 1000. D7 Unknown 1 511,00
A3 Unknown 1 FE7.00
G3 Unknown 1 31.00

Figure A.9 Example of the complex filter criteria
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A.2

Print Preview Menu

Print preview allows you to zoom, navigate, print out, set printing options,
export and other useful tasks (Figure A.10).

- Preview Menu y; Preview Toolbar
(& Preview - =B x
File WView Background
N e E e e 3ROk - & bobi| Bt B (G
Well | Sample Name | Group Name | MFI | MFI Average | Count | C
Bead Name: GM-CSF
Al Background 1 41.00 0.00 189
B1 Standard 1 10516.00 2970.39 208
1 Standard 1 . £152.00 2970.39 225
D1 Standard 1 Preview 3104.00 2970.39 213
Eil Standard 1 Area 1040.00 2970.39 181
F1 Standard 1 282,00 2970.39 165
G1 Standard 1 108.50 2970.39 150
H1 Standard 1 56.00 2970.39 183
A2 Background 1 39.00 0.00 194
B2 Standard 1 10034.50 2970.39 152
1 [
Current Page: 1 Total Pages: 17 - Zoom Factor: 130%
7~

Preview Status Bar

Figure A.10 Print Preview Window

Table A.4 Preview Toolbar buttons and functions
Ilcon Command Function

Search Search specific word or value from the

preview document.

Open Open preview document files(*.prnx).

E‘ Customize Customize the printing items.
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] Save Save preview document by *.prnx format.
17 Print... Open print dialog.
=l
1 Print Print the preview document.
=l
L Print Setup... Open print setup dialog.
Lt
= Header and Footer Set up header and footer options (Figure A.10).
| Scale Set page scale.
ol
T Hand Tool User hand icon
Sf
Magnifier User magnifier
-.2\-
i :‘L Zoom Out Zoom out the preview document.
— Zoom Set zoom size from the drop-down list.
J0% -
[ _l_‘:w Zoom In Zoom in the preview document.
First Page Show first page.

Previous Page

Show previous page.

Next Page

Show next page

Last Page

Show last page.

Multiple Pages

Select multi pages to preview.

Color...

Open color picker and set the document

background color.

MasterPlex® EX www.miraibio.com
115




APPENDIXA

PREFERENCES
I_I.I Water Mark... Open water mark setting dialog (Figure A.10).
o
Ly Export Document... | Export the document by selected format.
L[l:-l.] PDF, HTML, MHT, RTF, Excel, CSV, Text,
Image
| Send via E-Mail... Export the document by selected format, and
o~ send it via e-mail.
PDF, MHT, RTF, Excel, CSV, Text, Image
@ Exit Close preview window.
1

Insert Header/Footer

To insert header/footer into your printing document, open Header and Footer
dialog (Figure A.11). Select header or footer radio button, then input text or
items from the header/footer toolbar (Table A.5) in the left, center or right text
box.

Header/Footer toolbar

Header and Footer / X
1IN P i icr if &
|£L| I+_1';| J 0 2, [} olf \oly| Fent |Microsoft Sans Serif, 8.25pt A Left, center
and right
i Header: text box
_)Footer:
| K, | | Cancel

Figure A.11 Header and Footer dialog
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Table A.5 Header and Footer Toolbar buttons and functions

Icon Command Function

|£| Page Number Insert page number.

|+_L| Page # of Pages # | Insert ‘(current page) of (total pages)’ type
e page number.

3 Date Printed Insert date printed.

.:} Time Printed Insert time printed.

™ User Name Insert user name who login the windows.
-

Image Insert the image.

'J_u Align to Top Align all headers/footers to the top level.

of} Align to Center Align all headers/footers to the center level.
I Align to Bottom Align all headers/footers to the bottom level.

]

FDITI: Font Open font dialog for the header and footer font.
Insert Water Mark

To insert water marks into your printing document, open Water Mark dialog
(Figure A.12). There are two types of watermarks you can insert in your
document, one is ‘Text’ and another is ‘Picture’. They are separated into two
tabs. To insert a text watermark, use ‘Text Watermark’ tab. To insert a picture
watermark, use the ‘Picture Watermark’ tab.
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Watermark =
=gl Picture Watermark
Text: it
Direction: Oz . Colar: E=H

Font: Erdana 5 Size:

Transparency {0-255);

iIn front & Al ) Pages:

8 Behind Enter page numbers and/or page ranges
- = separated by commas, For example: 1,3,5-12

lé oK Si | Cancel

Figure A.12 Watermark dialog

Table A.6 Text Watermark properties

Property Function

Text Input text word in the text box or select predefined words from
the drop-down list
Predefined words: ASAP, CONFIDENTIAL, COPY, DO NOT
COPY, DRAFT, EVALUATION, ORIGINAL, PERSONAL,
SAMPLE, TOP SECRET, URGENT

Direction Select text direction from one of the followings:
Horizontal, Vertical, BackwardDiagonal, ForwardDiagonal

Color Open color picker and choose text font color.

Font Open font dialog and choose text font.

Size Specify text font size.

Transparency Set transparency for the insert text.

Position Select text position, In front or Behind.

Page Range Set page range for the text water mark.
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Table A.7 Picture Watermark properties

Property Function
Load image... Open file open dialog and specify the image file to be inserted.
Size mode Select one of the size mode from followings.
Clip: Insert the image as same size as original image.
Stretch: Stretch the image to horizontal direction.
Zoom: Zoom the image to the page.
Horizontal Set horizontal alignment, left, center or right.
alignment

Vertical alignment

Set vertical alignment, left, center or right.

Tiling Fill up the page by the image.
Transparency Set transparency for the insert image.
Position Select image position, In front or Behind.
Page Range Set page range for the image water mark.
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Smnd Hame: GHACSE

a1 Saciground 1 4100 am 138 10334 s
51 Sandard 1 1051500 2073 28 10429, 234314
c1 Siavderd 1 15200 @3 5 430808 234314
Dt Tanderd 1 310400 2M3m 213 258705 234314
E Saderd 1 104100 =Rk 181 121133 234314
= Standerd 1 2 2 185 a5 284314
=1 Tandard 1 1025 2073 190 34588 234314
Hi Sanderd 1 S50 573 133 w3 234314
a2 Sackground 1 0m am 194 £ EE
B2 Saderd 1 1013450 s 132 AT 234314
o Saderd 1 a3mn @78 245 04247 234314
o Tanderd 1 2005 2M3m m a1 234314
= Savderd 1 109400 @3 3 124338 234314
= Standerd 1 30000 23 217 o) 234314
a2 Saderd 1 10400 F=nE 253 3373 234314
2 Siaderd 1 550 %3 P 19904 234314
43 Uniénznm 1 Zm ESES 193 25450 e
B3 Wik 1 5500 4088 158 24047 iz
=] Unignznn 1 0 413 247 L i
03 Unignznn 1 4100 5 bic] 10334 a1
= Uik 1 asm 54033 20t PEET) iz
= Wniénznm 1 nm Sk 213 X an:
& Wik 1 asm 03 27 14307 b
H Unignznm 1 5100 R 177 18004 i
a4 Unignznn 1 12m S48 =53 3m7s b

Wk 1 51100 E L 23 388547 iz
ca Uitz 1 51100 ENE =) a4 &
D4 Wik 1 5100 £ L 42 441311 iz
= Uik 1 Moo T 185 254433 iz
4 Unignznn 1 112909 ESE ) 12739 a1
=5 Wik 1 14075 L 132 39388 ]
H Unignznn 1 zmam ENE 24 2w 1S i
a5 Wik 1 2m 54038 4 31071 b
BS Uik 1 1063 S 20 34185 iz
= Unignzn 1 ] ENES 72 P=H e
DS Wk 4 38N EE m 317784 iz
= M 1 13200 ENE 213 Perr i
= Unignznm 1 11300 ESE 179 380 a1
& Uik 1 1110 T 211 3M iz
H Wnignznn 1 a0 EES 201 21534 an:
45 Lncnama 1 M55 ESE 218 17204 b
86 Heienznn 1 1350 ENE 218 1m i
=3 Unignzm 1 =m ESE m 2831 b
DS Uk 1 130 L 218 35453 ]

Figure A.13 Example of the text and image watermark
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The toolbars that are available depend on the types of windows that are open
in the main display area.

B.1

Main File Menu and Toolbar

Table B.1 Main File menu and toolbar

Menu Bar Main Function
Command Toolbar
Button
File = Open _ Displays the Open dialog box so that a Luminex
J results file (.csv, .Ixd), BioPlex file (.xls) or
MasterPlex® EX file (.mlxe) may be opened.
File > Close r Close currently opened plate data file.
Ld
File > Save IH Save currently opened plate data.
File > Save as Save currently opened plate data as different file
) name.
File & Recent Files - List up the files recently opened.
File » Exit - Close MasterPlex® application.
Analyte Filter ‘# Valid analyte filter feature.
Virtual Plate Generate virtual plate. It opens plate dimension
F input dialog.
Windows - Show Set tab style window display
Tab style )
Windows - Arrange the window by cascade style.
Cascade )
Windows — Tile - Arrange the window by horizontal style.
Horizontal
Windows — Tile - Arrange the window by vertical style.
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Vertical

Tools - -
Applications

Open application license information dialog.

Tools » Plugins -

Open plugin license information dialog.

Tools - User -
Management

Open user management dialog.
(For 21 CFR Part 11 module only)

Tools = Log Viewer -

Open log viewer.
(For 21 CFR Part 11 module only)

Tools — Verify files -

Open verification checker dialog.
(For 21 CFR Part 11 module only)

Help —» Tutorial -

Open video tutorial.

Help - Online -
Support

Open support URL by the default browser.

Help » About -

Display splash screen with application version

information.

Look and Feel -

Change application skins.

B.2
Plate Tab Toolbar

The Plate tab toolbar is available on the top of the well grid in the plate tab.

B RO TITH I~ 5 R - S

Figure B.2 Plate toolbar

Table B.2 Plate toolbar buttons and functions

Menu Bar Toolbar | Function

Command Icon

Background u Mark selected wells as Background.
Control Mark selected wells as Control.
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Quality Control
Manager

Open Quality Control Manager.
(Optional module)

Template
Manager

Open template manager.

Plate

Open plate preference dialog.

Treatment “ Mark selected wells as Treatment.
Unmark ) Unmark selected wells.
Subtract Toggle subtract background function.
Background EXg
Link One vs. E Link between one control group and multiple
Multi treatment group.
Link adjacent E Link adjacent control groups and treatment
multiples groups.
Auto Fill =1 Open Auto Fill dialog.

e

Ii-e—ri

2

Preferences

B.3

Data Table Tab Toolbar

The Data Table toolbar is available on the top of the data grid in the Data

Table tab.

3 '| Show Calumn Selector

._ _.Expn:u'ttn File ) Print Preview Ei—_'; Table Template

Figure B.4 Calculation toolbar
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Table B.4 Calculation toolbar buttons and functions

Menu Bar Toolbar | Function
Command Button
Show/Hide Columns Show or hide columns selector.
Selector
Export to File Export data table by selected format.
- Format: Excel, CSV, PDF, HTML, Text

Print Preview r Open print preview window

| &%
Table Template Eﬁ_{ Open table template dialog
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B.4

Chart Tab Toolbar

The chart toolbar is available on the top of the chart view area in the chart tab.

Al

|

Figure B.5 Chart toolbar

14

EQE Tyl

Table B.5 Chart toolbar buttons and functions

Menu Bar
Command

Toolbar
Button

Function

Replicate View

Toggle replicate view mode.

Analyte Selector

Shows drop-down list for all analytes.

Well Selector

Shows mini-sized plate view.

Chart Gallery

Shows drop-down list of available chart format.

Color Palette

Shows drop-down list of available palette.

Chart Properties

Open chart properties dialog.

Chart Template

Open chart template manager.

Print Preview

Open print preview.
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B.5
Export Manager Tab Toolbar

The Export Manager toolbar is available on the top of the preview area in the
export manager tab.

£ Print
Figure B.5 Chart toolbar

Table B.6 Chart toolbar buttons and functions

Menu Bar Toolbar | Function

Command Button

Print Print current displayed document.
=
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